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Introduction

This core Microsoft® Excel® text provides students with the skills needed to execute many personal and professional
activities. It also prepares them to go on to more advanced skills using the Excel software. The text takes the approach
of making decisions using Excel. Personal decisions introduced include important purchases, such as homes and
automobiles, savings for retirement, and personal budgets. Professional decisions include budgets for managing
expenses, merchandise items to mark down or discontinue, and inventory management. Students are given clear, easy-
to-follow instructions for each skill presented and are also provided with opportunities to learn additional skills related
to the personal or professional objectives presented. For example, students learn the key terms with respect to home
mortgages and understand the impact interest rates have on monthly mortgage payments. This text also places an
emphasis on “what-if” scenarios so students gain an appreciation for the computational power of the Excel application.
In addition, students learn how Excel is used with Microsoft® Word® and Microsoft® PowerPoint® to accomplish a
variety of personal and professional objectives.
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PART I

CHAPTER 1 – FUNDAMENTAL SKILLS

Microsoft® Excel® is a tool that can be used in virtually all careers and is valuable in both professional and personal
settings. Whether you need to keep track of medications in inventory for a hospital or create a financial plan for your
retirement, Excel enables you to do these activities efficiently and accurately. This chapter introduces the fundamental
skills necessary to get you started in using Excel. You will find that just a few skills can make you very productive in a
short period of time.

Attribution

Adapted from How to Use Microsoft Excel: The Careers in Practice Series, adapted by The Saylor Foundation without
attribution as requested by the work’s original creator or licensee, and licensed under CC BY-NC-SA 3.0.
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1. 1.5 Chapter Practice

To assess your understanding of the material covered in the chapter, complete the following assignment.

Basic Monthly Budget for Medical Office

Download Data File: PR1 Data
Creating and maintaining budgets are common practices in many careers. Budgets play a critical role in helping a

business or household control expenditures. In this exercise you will create a budget for a hypothetical medical office
while reviewing the skills covered in this chapter.

1. Open the file name PR1 Data, then Save As PR1 Medical Office Budget.
2. Activate all the cell locations in the Sheet1 worksheet by clicking the Select All button in the upper left corner of

the worksheet.
3. In the Home tab of the Ribbon, set the font style to Arial and the font size to 12 points. Then click any cell to

Deselect.
4. Increase the width of Column A so all the entries in the range A3:A8 are visible. Place the mouse pointer between

the letter A and letter B of Column A and Column B. When the mouse pointer changes to a double arrow, left click
and drag it to the right until the character width is approximately 18.00.

5. Enter Quarter 1 in cell B2.
6. Use AutoFill to complete the headings in the range C2:E2. Activate cell B2 and place the mouse pointer over the Fill

Handle.
7. Select the range B2:E2 and click the Format button in the Home tab of the Ribbon. Click the Column Width option,

type 11.57 in the Column Width dialog box, and then click the OK button in the Column Width dialog box.
8. Enter the words Medical Office Budget in cell A1.
9. Insert a blank column between Columns A and B by clicking on any cell in Column B. Then, click the drop-down

arrow of the Insert button in the Home tab of the Ribbon. Click the Insert Sheet Columns option.
10. Enter the words Budget Cost in cell B2.
11. Adjust the width of Column B to approximately 12.0 characters.
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PR 1 Medical Office Budget Solution Screenshot

12. Select the range A1:F1 and click the Merge & Center button in the Home tab of the Ribbon to merge the cells in that
range.

13. Make the following format adjustments to the range A1:F1: bold; italics; change the font size to 14 points; change
the cell fill color to Aqua, Accent 5, Darker 50%; and change the font color to white.

14. Increase the height of Row 1 to approximately 24.75 points.
15. Make the following format adjustment to the range A2:F2: bold; and fill color to Tan, Background 2, Darker 10%.

Center the column titles so that they are horizontally centered in each cell.
16. Select B2 and choose the Wrap Text button in the Home tab of the Ribbon. Increase the height of Row 2 to

approximately 30 points.
17. Copy cell C3 and paste the contents into the range D3:F3.
18. Copy the contents in the range C6:C8 by highlighting the range and clicking the Copy button in the Home tab of

the Ribbon. Then, highlight the range D6:F8 and click the Paste button in the Home tab of the Ribbon.
19. Calculate the total budget for all four quarters for the salaries. Click cell B3 and click the down arrow on the

AutoSum button in the Formulas tab of the Ribbon. Click the Sum option from the drop-down list. Then, highlight
the range C3:F3 and press the ENTER key on your keyboard.

20. Copy the formula in cell B3 and paste them into the range B4:B8.
21. Format the range B3:F8 with Accounting format and zero decimal places.

If any of the cells display pound symbols (######), simply widen the column to display the values again.
22. Select the range A1:F8 and click the down arrow next to the Borders button in the Home tab of the Ribbon. Select

the All Borders option from the drop-down list.
23. Double click the Sheet1 worksheet tab to change the name of Sheet1 to the word Budget, and press the ENTER key.

Delete any unnecessary worksheets.
24. Change the orientation of the Budget worksheet so it prints landscape instead of portrait.
25. Use Fit to 1 page so the Budget worksheet prints on one piece of paper, if it does not already.
26. Add a header to the Budget worksheet that shows the date in the upper left corner and your name in the center.
27. Add a footer to the Budget worksheet that shows the page number in the lower right corner.
28. Check the spelling on the worksheet and make any necessary changes. Save PR1 Medical Office Budget workbook.
29. Compare your work to the screenshot below and then submit the PR1 Medical Office Budget workbook as

directed by your instructor.

Attribution

Adapted by Barbara Lave from How to Use Microsoft
Excel: The Careers in Practice Series, adapted by The
Saylor Foundation without attribution as requested by the
work’s original creator or licensee, and licensed under CC
BY-NC-SA 3.0.
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2. 1.6 Scored Assessment

Sales and Inventory Items

Download Data File: SC1 Data
A key activity for marketing professionals is to analyze projected sales and inventory information. This is especially

important for retail environments. This exercise utilizes the skills covered in this chapter to analyze sales and inventory
data.

1. Open the file named SC1 Data and then Save As SC1 Sales and Inventory
2. In the Sheet1 worksheet, enter the word Totals in cell C14.
3. Format all the cells in Sheet1 to Century font style and a 12-point font size.
4. Set the column width for Columns A through G to 13.5.
5. Edit the entry in cell B2 to read “Item Number.”
6. Use AutoFill to fill the Item Numbers from B3 into the range B4:B13. The item numbers should increase by one as

they are filled through the range.
7. Copy the contents of cell A3 and paste them into the range A4:A8.
8. Delete Column F.
9. Format the range A1:F2 so the text is Bold.

10. Set the alignment in the range A2:F2 to Wrap Text.
11. Prepare A1:F1 for the title text by changing the fill color of the cells in the range A1:F1 to Red, Accent 2, Darker 25%.
12. Make the following font changes to the range A1:F1: set the font color to white, add italics, and set the font size to

14.
13. Merge and center the cells in the range A1:F1.
14. Enter the title for this worksheet in the range A1:F1. The title should appear on two lines. The first line should

read Status Report. The second line should read Sales and Inventory by Item.
15. Increase the height of Row 1 so the entire title is visible.
16. Format the values in the range C3:C13 with dollar signs and two decimal places.
17. Format the values in the range E3:F13 with comma style, zero decimal places.
18. In cell E14, use AutoSum to calculate the sum of the values in the range E3:E13.
19. In cell F14, use AutoSum to calculate the sum of the values in the range F3:F13.
20. Apply All Borders to the range A1:F14.
21. Add a thick bottom border to row 2; add a thick bottom border to row 13.
22. Add a thick line border around the perimeter of the range A1:F14.
23. Insert a new blank worksheet in the workbook (this will be Sheet4).
24. Delete Sheet3.
25. Move Sheet4 ahead of Sheet2 so the order of the worksheets is Sheet1, Sheet4, and Sheet2.
26. Rename the Sheet1 worksheet tab to “Status Report.”
27. Change the orientation of the Status Report worksheet so it prints landscape instead of portrait.
28. Add a header to the Status Report worksheet that shows the date (needs to update) in the upper left corner and

your name in the center.
29. Add a footer to the Status Report worksheet that shows the page number in the lower right corner with the word

“Page” before the number.
30. Center the worksheet both horizontally and vertically on the sheet.
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31. Check the spelling of the worksheet and make any necessary changes. Save the SC1 Sales and Inventory
workbook.

32. Submit the SC1 Sales and Inventory workbook as directed by your instructor.

Attribution

Adapted by Barbara Lave from How to Use Microsoft Excel: The Careers in Practice Series, adapted by The Saylor
Foundation without attribution as requested by the work’s original creator or licensee, and licensed under CC BY-NC-
SA 3.0.
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PART II

CHAPTER 2 – MATHEMATICAL COMPUTATIONS

Perhaps the most valuable feature of Excel is its ability to produce mathematical outputs using the data in a workbook.
This chapter reviews several mathematical outputs that you can produce in Excel through the construction of formulas
and functions. The chapter begins with the construction of formulas for basic and complex mathematical computations.
The second section reviews statistical functions, such as SUM, AVERAGE, MIN, and MAX, which can be applied to a
range of cells. The last section of the chapter addresses functions used to calculate mortgage and lease payments as well
as the valuation of investments. This chapter also shows how you can use data from multiple worksheets to construct
formulas and functions. These skills will be demonstrated in the context of a personal cash budget, which is a vital tool
for managing your money for long-term financial security. The personal budget objective will also provide you with
several opportunities to demonstrate Excel’s what-if scenario capabilities, which highlight how formulas and functions
automatically produce new outputs when one or more inputs are changed.

Attribution

Adapted by Mary Schatz from How to Use Microsoft Excel: The Careers in Practice Series, adapted by The Saylor
Foundation without attribution as requested by the work’s original creator or licensee, and licensed under CC BY-NC-
SA 3.0.

Chapter 2 – Mathematical Computations | 7



8 | Chapter 2 – Mathematical Computations



3. 2.5 Chapter Practice

Financial Plan for a Lawn Care Business

Download Data File: PR2-Data
Running your own lawn care business can be an excellent way to make money over the summer while on break from

college. It can also be a way to supplement your existing income for the purpose of saving money for retirement or for
a college fund. However, managing the costs of the business will be critical in order for it to be a profitable venture. In
this exercise you will create a simple financial plan for a lawn care business by using the skills covered in this chapter.

There are two worksheets in the workbook you will be using.

• Annual Plan – provides calculations to determine how much money the lawn care business brings in for one year,
based on the average price per lawn cut and the number cut per year, as well as the expenses for the year.

• Equipment Loans – calculates the monthly payments for the various lawn care equipment loans.

Annual Plan Worksheet

1. Open the file named PR2 Data and then Save As PR2 Lawn Care.
2. Switch to the Annual Plan worksheet if needed.
3. Enter the following data into cells B14, B15, and B16:

◦ Gasoline cost (per cut) = $10
◦ Number of customers = 30
◦ Annual lawn cuts per customer = 20

4. In cell B3, enter the average price per lawn cut of $50.
5. In cell B4, write a formula that calculates the total number of lawns cut in the year. This is the number of customers

multiplied by the annual lawn cuts per customer.
6. In cell B5, write a formula that calculates the total annual sales. This is found by multiplying the average price per

lawn by the total number of lawn cuts.
7. In cell B8, write a formula to calculate the total cost of gasoline for the year. This is found by multiplying the

gasoline cost per cut by the total number of lawns cut.
8. You will finish the rest of this worksheet after completing the Equipment Loans worksheet.

Equipment Loans Worksheet

1. Switch to the Equipment Loans worksheet.
2. In cell E3, write a PMT function to calculate the monthly payment for the Commercial Lawn Mower. Don’t forget

the negative sign in between the equal sign and the PMT! Remember to convert the interest rate and years to monthly
terms and to use cell references. The arguments of the PMT function should be as follows:

◦ RATE: B3/12
◦ NPER: C3*12
◦ PV: D3
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3. Copy the PMT function from cell E3 to the other equipment items.
4. In cell E10, use the SUM function to calculate the total for the monthly loan payments. Make sure that the blank

rows (7 through 9) were included in the range for the SUM function so that you can add more equipment items
later if needed.

5. In cell E11, write a formula that calculates the total annual loan payments. This will be the monthly total multiplied
by 12 (the number of months in a year).

6. If needed, apply Accounting format to all of the monetary values so that the placement of the dollar sign is
consistent throughout the worksheet.

7. Sort the data in the range A3:E6 first by Interest Rate and then by Loan Amount using the following steps:

◦ Select the range A3:E6.
◦ Click the Sort button in the Data tab of the Ribbon.
◦ In the Sort dialog box, select the Interest Rate option in the “Sort by” drop-down box. Select Largest to

Smallest for the sort order.
◦ Click the Add Level button in the Sort dialog box.
◦ Select the Loan Amount option in the “Then by” drop-down box. Select Largest to Smallest for the sort order.
◦ Click the OK button in the Sort dialog box.

8. Add a header with the date on the left and the worksheet name on the right. Be sure to insert the date and
worksheet name so that they will automatically update.

9. Check Print Preview and make any other changes necessary for professional printing.

Complete the Annual Plan Worksheet

1. Switch back to the Annual Plan worksheet.
2. In cell B9, write a formula that displays the annual monthly payments total from cell E11 in the Equipment Loans

worksheet using the following steps:

◦ Type an equal sign =
◦ Click the Equipment Loans worksheet
◦ Click cell E11
◦ Press the ENTER key

3. In cell B10, calculate the Total Expenses by adding the Gasoline Cost and the Annual Equipment Payments.
4. In cell B12, calculate the Annual Profit by finding the difference between the Total Annual Sales and the Total

Expenses. Hint: This will hopefully be a positive number which shows that your business is making money instead of
losing money.

5. Format all cells that contain monetary amounts in the Annual Plan worksheet for Accounting Number Format ($)
with no decimal places. Format all other numerical values as Comma format with no decimal places.

6. Add a header with the date on the left and the worksheet name on the right. Be sure to insert the date and
worksheet name so that they will automatically update.

7. Check Print Preview and make any changes necessary for professional printing.
8. Check the spelling on all of the worksheets and make any necessary changes.

Compare both worksheets with the answer keys below.
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Attribution

Adapted by Mary Schatz from How to Use Microsoft Excel: The Careers in Practice Series, adapted by The Saylor
Foundation without attribution as requested by the work’s original creator or licensee, and licensed under CC BY-NC-
SA 3.0.
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4. 2.6 Chapter Scored

Hotel Occupancy and Expenses

Download Data File: SC2-Data
The hotel management industry presents a wide variety of career opportunities. These range from running a bed and

breakfast to a management position at a large hotel. No matter what hotel management career you choose to pursue,
understanding hotel occupancy and costs are critical to running a successful operation. This exercise examines the
occupancy rate and expenses of a small hotel.

There are three worksheets in the workbook for this assignment.

• Occupancy – calculates and displays the maximum hotel capacity for each month (based on the number of rooms,
the capacity of each room, and the number of days in the specific month), the actual occupancy (how many
actually stayed in the hotel that month), and the occupancy percentage (what percentage of capacity was the hotel
each month).

• Statistics – calculates and displays the highest, lowest, and average actual occupancy and occupancy percentages
form the Occupancy worksheet.

• Shuttle Purchase – calculates three different down payment options for a loan to purchase a shuttle for the hotel.

Occupancy Worksheet

1. Open the file named SC2 Data and then Save As SC2 Hotel.
2. Switch to the Occupancy worksheet if needed.
3. Replace the [Insert Year] in A1 with the year number for last year.
4. You need to calculate the January capacity for the hotel in C5. The capacity shows how many people the hotel can

hold during the month. It is calculated by first multiplying the occupants per room by the number of rooms in the
hotel. This result is then multiplied by the number of days in the month (cell B5 for January). Create this formula
using absolute references so that the appropriate cells do not change when the formula is pasted throughout
column C. Hint: two of the cells in the formula need to be absolute references.

5. Copy the formula in cell C5 and paste it into the range C6:C16. Use a paste method that does not remove the
border at the bottom of cell C16.

6. Format the numbers in columns C and D for comma format with zero decimal places.
7. In cell C17, enter a function that finds the sum of the monthly hotel capacity values. Do the same in cell D17 to find

the sum of the monthly actual occupancy values.
8. Enter a formula in cell E5 to calculate the Percent Occupied of the hotel (this statistic shows what percentage of

the hotel is full or occupied). Your formula should divide the Actual Occupancy by the Hotel Capacity. Then copy
and paste the formula into the range E6:E17. Use a paste method that does not remove the borders at the bottom
of cell E16 and E17. Format the results in E5:E17 as percentages with two decimal places.

9. Format the Totals (C17:E17) as bold.
10. Apply any number formatting that aids in the readability and professionalism of the worksheet.
11. Check Print Preview and make any changes necessary for professional printing.

Statistics Worksheet

14 | 2.6 Chapter Scored



1. Replace the [Insert Year] in A1 with the year number for last year.
2. Enter a function in cell B3 that finds the highest value in the Actual Occupancy column from the Occupancy

worksheet.
3. Enter a function in cell B4 that finds the lowest value in the Actual Occupancy column from the Occupancy

worksheet.
4. Enter a function in cell B5 that shows the average value of the Actual Occupancy column on the Occupancy

worksheet.
5. Use the Auto Fill handle to copy the formulas in the range B3:B5 to the range C3:C5.
6. Apply any number formatting that aids in the readability and professionalism of the worksheet. The numbers

should be formatted similarly to the Occupancy worksheet.
7. Check Print Preview and make any changes necessary for professional printing.

Shuttle Purchase Worksheet
The hotel is considering buying a car to shuttle customers to and from the airport. You need to decide how much of

a down payment to make, so you are going to calculate the monthly payment based on three different down payment
percentages. The number of years to pay off the loan will vary for each of the down payment percentage options.
Remember, the down payment amount is found by multiplying the price of the car by the down payment percentage.
This amount is then subtracted from the price of the car to find the amount of the loan.

1. In cell B5 write a formula that will calculate the amount of the down payment. Be sure to use cell references as
much as possible. Copy the formula to the other down payment options.

2. In cell B6 write a formula to calculate the amount of the loan. Be sure to use cell references as much as
possible.Copy the formula to the other down payment options.

3. In cell B9 create a PMT function to calculate the monthly payment. Make sure the arguments in the PMT function
are converted into months and that the monthly payment is a positive number. Be sure to use cell references as

much as possible. Copy the function to the other down payment options.
4. In cell B10 create a formula that calculates how much will be paid in total for the vehicle, including the down

payment and the total amount paid on the loan in the given number of years. Copy the formula to the other down
payment options.

5. In cell A12, write an explanation of which down payment option is the best and why.
6. Apply any number formatting that aids in the readability and professionalism of the worksheet.
7. Make the following page setup changes to the worksheet:

◦ Center horizontally on the page
◦ Create a footer with the date on the left and the file name on the right. Make sure that both the date and the

file name will update automatically.

8. Check the spelling on all of the worksheets and make any necessary changes.
9. Save the SC2 Hotel workbook and submit the workbook as directed by your instructor.

Attribution

Adapted by Mary Schatz from How to Use Microsoft Excel: The Careers in Practice Series, adapted by The Saylor
Foundation without attribution as requested by the work’s original creator or licensee, and licensed under CC BY-NC-
SA 3.0.
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PART III

CHAPTER 3 – FORMULAS, FUNCTIONS, LOGICAL
AND LOOKUP FUNCTIONS

Excel workbooks are designed to allow you to create useful and complex calculations. In addition to doing arithmetic,
you can use Excel to look up data, and to display results based on logical conditions. We will also look at ways to highlight
specific results. These skills will be demonstrated in the context of a typical gradebook spreadsheet that contains the
results for an imaginary Excel class.

In this chapter, we will:

• Use the Quick Analysis Tool to find the Total Points for all students and Points Possible.

(Note for Mac Users: the Quick Analysis Tool is not available with Excel for Mac. We have alternate steps for
Mac Users)

• Write a division formula to find the Percentage for each student, using an absolute reference to the Total Points
Possible.

• Write an IF Function to determine Pass/Fail – passing is 70% or higher.
• Write a VLOOKUP to determine the Letter Grade using the Letter Grades scale.
• Use the TODAY function to insert the current date.
• Review common Error Messages using Smart Lookup to get definitions of some of the terms in your spreadsheet.
• Apply Data Bars to the Total Points values.
• Apply Conditional Formatting to the Percentage, Pass/Fail, and Letter Grade columns.
• Printing Review – Change to Landscape, Scale to Fit Columns on One Page and Set Print Area.

Figure 3-1 shows the completed workbook that will be demonstrated in this chapter. Notice the techniques used in
columns O and R that highlight the results of your calculations. Notice, also that there are more numbers on this version
of the file than you will see in your original data file. These are all completed using Excel calculations.

Figure 3.1 Completed Gradebook Worksheet
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Portland Community College, is licensed under CC BY 4.0
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Figure 3.2 Entering a
function

5. 3.1 More on Formulas and Functions

Learning Objectives

1. Review the use of the =MAX function.
2. Examine the Quick Analysis Tool to create standard calculations, formatting, and charts very quickly.
3. Create Percentage calculation.

– Use the Smart Lookup tool to acquire additional information about percentage calculations.
– Review the use of Absolute cell reference in a division formula.

Another use for =MAX

Before we move on to the more interesting calculations we will be discussing in this chapter, we need to determine how
many points it is possible for each student to earn for each of the assignments. This information will go into Row 25. The
=MAX function is our tool of choice.

Download Data File: CH3 Data

1. Open the data file CH3 Data and save the file to your computer as CH3 Gradebook and Parks.
2. Make B25 your active cell.
3. Start typing =MAX (See Figure 3.2) Note the explanation you see on the offered list of functions. You can either

keep typing ( or double click MAX from the list.

4. Select the range of numbers above row 25. Your calculation will be: =MAX(B5:B24).
5. Press Enter after selecting the range.
6. Now, use the Fill Handle to copy the calculation from Column B through Column N.

Note that as you copy the calculation from one column to the next, the cell references change. The calculation in
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Figure 3.3 Relative
References – Displayed
as calculations.

Figure 3.4 Quick
Analysis Tool

column B reads: =MAX(B5:B24). The one in column N reads: =MAX(N5:N24). These cell references are relative
references.

By default, the calculations that Excel copies change their cell references relative to the row or column you copy them
to. That makes sense. You wouldn’t want column N to display an answer that uses the values in column L.

Want to see all the calculations you have just created? Press Ctrl ~ (See Figure 3.3.) Ctrl ~ displays your calculations
(formulas). Pressing Ctrl ~ a second time will display your calculations in the default view – as values.

Quick Analysis Tool

The Quick Analysis Tool allows you to create standard calculations, formatting, and charts very quickly. In this exercise
we will use it to insert the Total Points for each student in Column O.

Mac Users: the Quick Analysis Tool is not available with Excel for Mac. We
have alternate steps for Mac Users below. Skip down below Figure 3.5 to
continue.)

Be sure to press Ctrl ~ to return your spreadsheet to the normal view (the formula results should display, not the
formulas themselves).

1. Select the range of cells B5:N25
2. In the lower right corner of your selection, you will see the Quick Analysis tool (see Figure 3.4).

3. When you click on it, you will see that there are a number of different options. This time we will be using the
Totals option. In future exercises, we will use other options.

4. Select Totals, and then the SUM option that highlights the right column (see Figure 3.5). Selecting that SUM
option places =SUM() calculations in column O.
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Figure 3.5 Quick
Analysis Tool – Totals,
Sum Column

Alternate steps for Mac Users:

1. Select the range B5:O25 then click the AutoSum button on the Ribbon (Home tab or Formulas tab)
2. Select the range O5:O25 and click the Bold button.

Percentage calculation

Column P requires a Percentage calculation. Before we launch into creating a calculation for this, it might be handy to
know precisely what it is we are looking for. If you are connected to the internet and are using Excel 365, you can use
the Smart Lookup tool to get some more information about calculating percentages.

In general, the Smart Lookup tool allows you to get more information and definitions about unfamiliar terms or
features. This tool is available in all of the Microsoft Office applications.

1. Select cell P4.
2. Find the Smart Lookup tool on the Review tab (see Figure 3.6) and click it. You can also “Right-click” the specific

cell and choose Smart Lookup.

Mac Users: The Smart Lookup tool is only on the Review tab in the latest versions of Excel for Mac. If you
can’t find the Smart Lookup tool on the Review tab, you will find it by clicking on the “Tools” menu bar option.
Note for all users: there is a keyboard shortcut for using the Smart Lookup tool. You can hold down the Control
key and click in the specific cell (in this case, P4)

3. If this is the first time you have used the Smart Lookup tool, you may need to respond to a statement about your
privacy. Press the Got it button. We think the Wikipedia article does a pretty good job explaining the calculation,
don’t you?

4. Close the Smart Lookup pane after reading through the definitions.
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Figure 3.6 Smart Lookup
tool

Now that we know what is needed for the Percentage calculation, we can have Excel do the calculation for us. We need
to divide the Total Points for each student by the Total Points of all the Points Possible. Notice that there is a different
number on each row – for each student. But, there is only one Total Points Possible – the value that is in cell O25.

1. Make sure that P5 is your active cell.
2. Press = then select cell O5. Press /, then cell O25. Your calculation should look like this: =O5/O25. The result of the

formula should be 0.95641026. (So far, so good. DeShea Andrews is doing well in this class – with a percentage
grade of almost 96%. Definitely an “A”!)

3. Next use the Fill handle to copy the calculation down through row 24 to calculate the other students’ grades. You
should get the error message #DIV/0!. This error message reminds us that you can’t divide a number by 0 (zero).
And that is just what is happening. If you look at the calculation in P9, the calculation reads: =O9/O29. The first cell
reference is correct – it points to Moesha Gashi’s total points for the class. But the second reference is wrong. It
points to an empty cell – O29.

Before copying the calculation, we have to make the second reference (O25) an absolute cell reference. That way, when
we copy the formula down, the cell reference for O25 will be locked and will not change.

1. Make P5 your active cell. In the Formula Bar click on O25 (see Figure 3.7).
2. Press F4 (on the function keys at the top of your keyboard). That will make the O25 reference absolute. It will not

change when you copy the calculation (see Figure 3.8). (If you are working on a laptop and do not have an F4
function key, you can type in a $ before the O and another one before the 25.)

3. The calculation now looks like this: =O5/$O$25.
4. Use the Fill Handle to copy the formula down through P24 again. Now, when you copy the formula, you will get

correct values for all of the students.
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Figure 3.7 Editing a
formula

Figure 3.8 Absolute Cell
reference – press F4

Those long decimals are a bit nonstandard. Let’s change them to % by applying cell formatting.

1. Select the range P5:P24.
2. On the Home tab, in the Number Group, select the % (Percent Style) button.

Skill Refresher

Absolute References

1. Click in front of the column letter of a cell reference in a formula or function that you do not want
altered when the formula or function is pasted into a new cell location.
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2. Press the F4 key or type a dollar sign ($) in front of the column letter and row number of the cell
reference.

Keyboard Shortcuts

Smart Lookup Tool

• Hold down the CTRL key and click the specific cell that you are working with. Then choose “Smart
Lookup“

• Mac Users: Same as above

Key Takeaways

• Functions can be created using cell ranges or selected cell locations separated by commas. Make sure
you use a cell range (two cell locations separated by a colon) when applying a statistical function to a
contiguous range of cells.

• To prevent Excel from changing the cell references in a formula or function when they are pasted to a
new cell location, you must use an absolute reference. You can do this by placing a dollar sign ($) in front
of the column letter and row number of a cell reference or by using the F4 function key.

• The #DIV/0 error appears if you create a formula that attempts to divide a constant or the value in a
cell reference by zero.

More functions:

Create the Sample Worksheet

This section uses a sample worksheet to illustrate Excel built-in functions. Consider the example of referencing a name
from column A and returning the age of that person from column C. To create this worksheet, enter the following data
into a blank Excel worksheet.

You will type the value that you want to find into cell E2. You can type the formula in any blank cell in the same
worksheet.
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A B C D E

1 Name Dept Age Find Value

2 Henry 501 28 Mary

3
Stan

201 19

4 Mary 101 22

5 Larry 301 29

Term Definition Example

Table Array The whole lookup table A2:C5

Lookup_Value The value to be found in the first column of Table_Array. E2

Lookup_Array
-or-
Lookup_Vector

The range of cells that contains possible lookup values. A2:A5

Col_Index_Num The column number in Table_Array the matching value should be returned for.
3 (third
column in
Table_Array)

Result_Array
-or-
Result_Vector

A range that contains only one row or column. It must be the same size as Lookup_Array or
Lookup_Vector. C2:C5

Range_Lookup A logical value (TRUE or FALSE). If TRUE or omitted, an approximate match is returned. If FALSE,
it will look for an exact match. FALSE

Top_cell This is the reference from which you want to base the offset. Top_Cell must refer to a cell or
range of adjacent cells. Otherwise, OFFSET returns the #VALUE! error value.

Offset_Col

CONCAT

This is the number of columns, to the left or right, that you want the upper-left cell of the result
to refer to. For example, “5” as the Offset_Col argument specifies that the upper-left cell in the
reference is five columns to the right of reference. Offset_Col can be positive (which means to
the right of the starting reference) or negative (which means to the left of the starting
reference).

This is used for text that needs to be merged into one cell. You can type data into cells, then
by using the CONCAT function and the range or cells you want to use, the data will be merged
into the cell reference. For example, if you have the words “Red” in cell C2 and “Cat” in cell C3,
by using CONCAT in cell C4, you can have the words Red Cat appear in that cell.

Functions

LOOKUP()

The LOOKUP function finds a value in a single row or column and matches it with a value in the same position in a
different row or column.

The following is an example of LOOKUP formula syntax:
=LOOKUP(Lookup_Value,Lookup_Vector,Result_Vector)
The following formula finds Mary’s age in the sample worksheet:
=LOOKUP(E2,A2:A5,C2:C5)
The formula uses the value “Mary” in cell E2 and finds “Mary” in the lookup vector (column A). The formula then

3.1 More on Formulas and Functions | 25



matches the value in the same row in the result vector (column C). Because “Mary” is in row 4, LOOKUP returns the
value from row 4 in column C (22).

NOTE: The LOOKUP function requires that the table be sorted.

For more information about the LOOKUP function, click the following article number to view the article in the
Microsoft Knowledge Base:
How to use the LOOKUP function in Excel

VLOOKUP()
The VLOOKUP or Vertical Lookup function is used when data is listed in columns. This function searches for a value in
the left-most column and matches it with data in a specified column in the same row. You can use VLOOKUP to find
data in a sorted or unsorted table. The following example uses a table with unsorted data.The following is an example
of VLOOKUP formula syntax:=VLOOKUP(Lookup_Value,Table_Array,Col_Index_Num,Range_Lookup)

The following formula finds Mary’s age in the sample worksheet:
=VLOOKUP(E2,A2:C5,3,FALSE)
The formula uses the value “Mary” in cell E2 and finds “Mary” in the left-most column (column A). The formula then

matches the value in the same row in Column_Index. This example uses “3” as the Column_Index (column C). Because
“Mary” is in row 4, VLOOKUP returns the value from row 4 in column C (22).

For more information about the VLOOKUP function, click the following article number to view the article in the
Microsoft Knowledge Base:
How to Use VLOOKUP or HLOOKUP to find an exact match

INDEX() and MATCH()
You can use the INDEX and MATCH functions together to get the same results as using LOOKUP or VLOOKUP.The
following is an example of the syntax that combines INDEX and MATCH to produce the same results
as LOOKUP and VLOOKUP in the previous
examples:=INDEX(Table_Array,MATCH(Lookup_Value,Lookup_Array,0),Col_Index_Num)

The following formula finds Mary’s age in the sample worksheet:
=INDEX(A2:C5,MATCH(E2,A2:A5,0),3)

The formula uses the value “Mary” in cell E2 and finds “Mary” in column A. It then matches the value in the same row
in column C. Because “Mary” is in row 4, the formula returns the value from row 4 in column C (22).

NOTE: If none of the cells in Lookup_Array match Lookup_Value (“Mary”), this formula will return #N/A.
For more information about the INDEX function, click the following article number to view the article in the Microsoft
Knowledge Base:

How to use the INDEX function to find data in a table
OFFSET() and MATCH()

You can use the OFFSET and MATCH functions together to produce the same results as the functions in the previous
example.The following is an example of syntax that combines OFFSET and MATCH to produce the same results
as LOOKUP and VLOOKUP:=OFFSET(top_cell,MATCH(Lookup_Value,Lookup_Array,0),Offset_Col)

This formula finds Mary’s age in the sample worksheet:
=OFFSET(A1,MATCH(E2,A2:A5,0),2)
The formula uses the value “Mary” in cell E2 and finds “Mary” in column A. The formula then matches the value in the

same row but two columns to the right (column C). Because “Mary” is in column A, the formula returns the value in row
4 in column C (22).

For more information about the OFFSET function, click the following article number to view the article in the
Microsoft Knowledge Base:

Using the OFFSET function
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Using the some of the functions exercise

To complete this assignment, you will be required to use this data file: SC_EX_3.1b

• Start Excel and open the workbook in the datafile3.1b.xlsx. This workbook contains loan information for
which you will create a loan payment calculator.

• Select the range b4:c9, Use the “Create from Selection button (Formulas tab | Defined Names group) to
create names for the cells in range C4:C9 using the row titles in the range B4:B9.

• Enter the formulas shown in the table below

Cell Formula

C8

C9
F4
G4
H4

=Price-Down_Payment
=-PMT(Interest_Rate/12, 12*Years,

Loan_Amount)
=Monthly_Payment
=12*Monthly_Payment*Years=Down_Payment
=G4-Price

• Use the Data Table button in the What-If Analysis gallery (Data tab | Forecast group) to define the range
E4:H19 as a one-input data table. Use the Interest Rate in the Laon Payment Calculator as the column
input cell.

• Use the Page Setup dialog box to select the Fit to and “Black and White” options. Select the range B2:C9
and then use the “Set Print Area” command to set a print area. Use the Print button on the Print Screen in
Backstage view to print the worksheet. Use the “Clear Print Area” command to clear the print area.

• Name the following ranges: B2:C9-Calculator; E2:H19-Raqte_Scheudle: and B2:H19-All_Section. Print
each range by selecting the name in the Name box and using the print Selection optoin on the Print
screen in backstage view.

• Unlock the range C3:C7. Protect the worksheet so that the user can select only unlocked cells
(challenge).

• Press CTRL+` and then print the formulas verson in landscape orientation. Press CTRL+` again to
return to the values version.

• Hide and then unhide the Laon Payment Calculator workshee4t. Hide and then unhide the workbook.
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Delete the extra worksheet you made so you can hide the loan payment Calculator worksheet. Unprotect
the worksheet and then hide columns E through H. Select columns D and I and reveal the hidden
columns. Hide rows 11 through 19. Print the worksheet (Use print screen or create a print screen PDF
from the Print options). Select rows 10 and 20 and unhide rows 11 through 19. Protect the worksheet.

• Copy the data from the car worksheet to a new worksheet. Determine the monthly payment and print
the worksheet for each data set and set each to a new worksheet: (a) Item=Motorhome; Down payment =
$75,000.00; Price = $225,000; Years = 7; Interest rate = 8.00; (b) Item=Debt Consolidation Loan; Down
Payment – $0.0; Price = $40,000.00; Years =5; Interest rate = 11.35. Label each sheet tab with an
appropriate label for each calculations set and add your initials to each worksheet tab.

• Save the workbook with the file name, SC_EX_4_Loan+ your initials and upload to the assignment
specified by your instructor.

Attribution

3.1 More on Formulas and Functions by Noreen Brown, Mary Schatz, and Art Schneider, Portland Community College, is
licensed under CC BY 4.0

Support.microsoft.com and Jennifer Evans, South Puget Sound Community College, is licensed under CC by 4.0
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6. 3.2 Logical and Lookup Functions

Learning Objectives

• Use an IF Function to make logical comparisons between a value and what you expect.
• Create a VLOOKUP calculation to look up information in a table.
• Understand error messages.
• Understand how to enter and format Date/Time Functions.

In addition to doing arithmetic, Excel can do other kinds of functions based on the data in your spreadsheet. In this
section, we will use an =IF function to determine whether a student is passing or failing the class. Then, we will use a
=VLOOKUP function to determine what grade each student has earned.

IF Function

The IF function is one of the most popular functions in Excel. It allows you to make logical comparisons between a value
and what you expect. In its simplest form, the IF function says something like:
If the value in a cell is what you expect (true) – do this. If not – do that.

The IF function has three arguments:

• Logical test – Here, we can test to see if the value in a selected cell is what we expect. You could use something
like “B7=14” or “B7>12” or “B7<6”

• Value_if_true – If the requirements in the logical test are met – if B7 is equal to 14 – then it is said to be true. For
this argument, you can type text – “True”, or “On budget!” Or you could insert a calculation, like B7*2 (If B7 does
equal 14, multiply it by 2). Or, if you want Excel to put nothing at all in the cell, type “” (two quotes).

• Value_if_false – If the requirements in the logical test are not met – if B7 does not equal 14 – then it is said to be
false. You can enter the same instructions here as you did above. Let’s say that you type the double quotes here.
Then, if B7 does not equal 14, nothing will be displayed in this cell.

In column Q we would like Excel to tell us whether a student is passing – or failing the class. If the student scores 70%
or better, he/she will pass the class. But, if he/she scores less than 70%, he/she is failing.

1. Make sure that Q5 is your active cell.
2. On the Formulas tab, in the Function Library group, find the IF function on the Logical pulldown menu (see

Figure 3.9).

Mac Users: There is no “Function Library” group for Excel for Mac. Mac Users should click on the

Formulas tab, then click the “Logical” tool list arrow, and choose IF (see Figure 3.9).
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Figure 3.9 IF Function

Figure 3.10 IF Function
Dialog Box

Now you will see the IF Function dialog box, with a place to enter each of the three arguments.

Mac Users: There is no “dialog box”. The “Formula Builder” pane will display at the right side of the Excel window. It
has the same layout as Figure 3.10 below.

1. Click in the box for Logical Test. We need to test whether a student’s score is less than .7. So, in this box, type P5<.7
2. Click in the box for Value_if_true. If the student’s score is less than .7, then they are failing the class. In this box,

type Fail.
3. Click in the box for Value_if_false. If the student’s score is NOT less than .7, then they are passing the class. In

this box, type Pass.
4. Make sure that your dialog box matches Figure 3.10.

While we are here, let’s take a look at the dialog box. Notice that as you click in each box, Excel gives you a brief
explanation of the contents (in the middle below the boxes.) In the lower left-hand corner, you can see the results
of the calculation. In this case, DeShae is passing the class. Below that is a link to Help on this function. Selecting
this link will take you to the Excel help for this function – with detailed information on how it works.

5. Once you have typed in the required arguments and reviewed to make sure they are correct, press OK.

Mac Users should click the “Done” button, then close the Formula Builder pane.
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(The text Pass should be displayed in Q5 because DeShae is passing the class.)
6. Use the Fill handle to copy the IF function down through row 24.
7. Click on Q5. When you look in the formula bar, you will see the IF calculation: =IF(P5<0.7,”Fail”,”Pass”) (see Figure

3.11).

<img class=”wp-image-179 size-full” src=”https://spscc.pressbooks.pub/app/uploads/sites/50/2021/05/
Figure-3-11.jpg” alt=”Formula bar shows IF function (=IF(PS Figure 3.11 IF Function Results

VLOOKUP Function

You need to use a VLOOKUP function to look up information in a table. Sometimes that table is on a different sheet
in your workbook. Sometimes it is in another file entirely. In this case, we need to know what grade each student is
getting based on their percentage score. You will find the table that defines the scores and the grades in A28:B32.

There are four pieces of information that you will need in order to build the VLOOKUP syntax. These are the four
arguments of a VLOOKUP function:

• The value you want to lookup, also called the Lookup_value. In our example, the lookup value will be the student’s
percentage score in column P.

• The Table_array is the range (table) where the lookup values and the values you want returned by the function are
located. In our example, this is the table of percentages and corresponding letter grades in the range A28:B32. The
lookup value should always be in the first column in the table array for VLOOKUP to work correctly. For example,
in our table_array the lookup value is in cell A28, so the range should start with A.

• The Col_index_num is the column number in the range that contains the value to return. In our example, when
you specify A28:B32 as the Table_array range, you should count A as the first column (1), B as the second column
(2), and so on. You will enter the appropriate column number in this box as 1, 2, or 3 and so on.

• In the Range_lookup, you can optionally specify TRUE if you want an approximate match or FALSE if you want an
exact match of the return value. If you leave this blank, the default value will always be TRUE, or approximate
match.

Let’s create the VLOOKUP to display the correct Letter Grade in column R.

1. Make sure that R5 is your active cell.
2. On the Formulas tab, in the Function Library, find the VLOOKUP function on the Lookup & Reference pull-down

menu (see Figure 3.12).

Mac Users should click the Lookup and Reference tool list arrow to find the VLOOKUP function.
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Figure 3.12 VLOOKUP
Function

3. Fill in the dialog box so that it looks like the image in Figure 3.13.

Mac Users will use the “Formula Builder” pane at the right side of the Excel Window.

◦ Lookup_value – In this case, we will use the Percentage score. So, P5 for the first lookup value.
◦ Table_array – This is the range that contains the value you want returned by the function. In this case, that

range is A28:B32. Note that this range does NOT include the label in row 27; just the actual data. The cell
references for the Table_array need to be absolute – $A$28:$B$32. When we copy this function to the other
cells, we do not want these cell references to change. It should always be $A$28:$B$32. This is very important!
They must have the absolute reference symbols or the calculations will not work.

◦ Col_index_number – This is the column in the table array range that includes the information that we are
looking up. In our case, the actual grades are in the 2nd column of the range. So, the column index will be 2.

◦ Range_lookup – In some cases, you will need something in the Range_lookup box. Since we are looking for an
approximate match for the percentages, we want the default value of TRUE, so we do not need to enter
anything for this argument.

2. While you are in the dialog box, be sure to look at all the helpful definitions that Excel offers.
3. When you have filled in the dialog box, press OK.

Mac Users should click the “Done” button, then close the Formula Builder pane.
4. The calculation you will see in the formula bar is: =VLOOKUP(P5,$A$28:$B$32,2)
5. Use the fill handle to copy the function down through row 24. The results displayed should match Figure 3.14.
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Figure 3.13 VLOOKUP
completed dialog box

Figure 3.14 VLOOKUP
Complete

Note: What if it didn’t work? What if you get a result different from the one predicted? In this case, either you have
made a previous error, resulting in different % scores than this exercise anticipated, or you made a mistake entering
your VLOOKUP function.

To make repairs in the function, make sure that R5 is your active cell. On the Formula bar, press the Insert Function
button (see Figure 3.15). That will reopen the dialog box so you can make your repairs. Did you forget to make the cell
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Figure 3.15 Insert
Function

references for the Table_array absolute? Did you use the wrong cell for the Lookup_value? Press OK when you are done
and recopy the corrected function.

Error Messages

Sometimes Excel notices that you have made errors in your calculations before you do. In those cases Excel alerts you
with some slightly mysterious error messages. A list of common error messages can be found in Table 3.1 below.

Table 3.1 – Common Error Messages

Message What Went Wrong

#DIV/0! You tried to divide a number by a zero (0) or an empty
cell.

#NAME
You used a cell range name in the formula, but the name isn’t
defined. Sometimes this error occurs because you type the name
incorrectly.

#N/A

The formula refers to an empty cell, so no data is available
for computing the formula. Sometimes people enter N/A in a cell as
a placeholder to signal the fact that data isn’t entered yet.
Revise the formula or enter a number or formula in the empty
cells.

#NULL The formula refers to a cell range that Excel can’t understand.
Make sure that the range is entered correctly.

#NUM An argument you use in your formula is invalid.

#REF The cell or range of cells that the formula refers to aren’t
there.

#VALUE
The formula includes a function that was used incorrectly,
takes an invalid argument, or is misspelled. Make sure that the
function uses the right argument and is spelled correctly.

This table was copied from the internet. Look here for additional information.
http://www.dummies.com/software/microsoft-office/excel/how-to-detect-and-correct-formula-errors-in-excel-2016/
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Figure 3.16 Date & Time
Functions

Date Functions

Very often dates and times are an important part of Excel data. Numbers that are correct today may not be accurate
tomorrow. So, it is frequently useful to include dates and times on your spreadsheets.

These dates and times fall into two categories – ones that:

• Remain the same. For instance, if a spreadsheet includes data for May 15th, you don’t want the date to change
each time you re-open the spreadsheet.

• Change to reflect the current date/time. When it is important to have the current date or time on a spreadsheet,
you want Excel to update the information regularly.

Take a look at the list of Date and Time functions offered in the Function Library on the Formulas tab (see Figure 3.16).

For our gradebook, we want the date and time to be displayed in A2, and it needs to update whenever the workbook file
is opened.

1. Make A2 your active cell. Notice that A2 extends all the way from column A to Column R. Previously, someone has
used the Merge & Center tool on this cell to make it match the title above.

2. On the Formulas tab, in the Function Library, select NOW from the Date & Time drop-down list and then click OK.

Mac Users click the “Done” button in the “Formula Builder” pane at the right side of the Excel window; then
close the pane.

3. The result you will see in the formula bar is: =NOW(). The result you will see in A2 depends on the current date and
time. The NOW function is a very handy function. It takes no arguments and is Volatile! That is not as alarming as it
may seem. This just means that you don’t need to give it any more information to do its job and that your results
will change frequently. You can update the date and time whenever you want – you don’t have to wait until you
open the workbook again.

4. Make sure that A1 is your active cell and press the F9 function key (along the top of your keyboard.) The time will
update.
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Figure 3.17 Number
Format Launcher

Excel will update this field independently whenever you save and re-open the file, or print it. It may happen more
frequently than that – depending on how you have set this up in your installation of Excel.

Another variation of the current date is the TODAY function. Let’s try that one next.

1. Make sure A2 is your active cell. Press Delete to remove the NOW function.
2. From the Date & Time drop-down list in the Function Library on the Formulas tab (see Figure 3.16), select TODAY

and then click OK.

Mac Users click the “Done” button in the “Formula Builder” pane; then close the pane.
3. The result you will see in the formula bar is: =TODAY(). The result you will see in A2 depends on the current date.

Since we haven’t asked for the time, the time you are seeing is likely 12:00. That is not very helpful so we need to
change the format of the date.

4. On the Home tab, in the Number group, press the Number Format Launcher button (see Figure 3.17).

5. In the Format Cells dialog box, click the Number tab. Choose the Date
category and select Wednesday, March 14, 2012 (this format is
called Long Date).

Mac Users: there is no Number Format Launcher button or “Format Cells” dialog box.

Click the list arrow next to “Date” and choose “Long Date”

6. The current day and date will display in A2.
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Keyboard Shortcuts

Sometimes you want the date or the time to show up in your spreadsheet, but you don’t want it to change.
You can simply type in the date or time. Or, you can use shortcut keys.

• CTRL ; (semi colon) will bring you the current date

Mac Users: same as above

• CTRL : (colon or CTRL SHIFT ; ) will bring you the current time.

Mac Users: SHIFT COMMAND :

Key Takeaways

• Functions don’t always have to be about arithmetic. Excel provides functions that will help you perform
logical evaluations, look things up, and work with dates and times.

• Excel displays error messages when your formulas and functions are not constructed properly.

Attribution

3.2 Logical and Lookup Functions by Noreen Brown and Mary Schatz, and Art Schneider, Portland Community College,
is licensed under CC BY 4.0
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Figure 3.18 Data Bars on
the Quick Analysis tool

7. 3.3 Conditional Formatting

Learning Objectives

• Use Conditional Formatting techniques to provide flexible highlighting, applying specified formatting
only when certain conditions are met. Techniques include:

◦ Data bars — to make it easy to visualize values in a range of cells.
◦ Cells Rules — to highlight values that match the requirements you specify.

You now have all the calculations you need in your CAS 170 Grades spreadsheet. There is a lot of data here. To make
it easier to pick out the most important pieces of data, Excel provides Conditional Formatting. The best thing about
Conditional Formatting is that it is flexible, applying specified formatting only when certain conditions are met.

1. Select the values in the Total Points column (O5:O24).
2. At the bottom of your selection, click on the Quick Analysis Tool. On the Formatting tab, select Data Bars

(see Figure 3.18).

Mac Users: as stated previously, there is no Quick Analysis Tool for Excel for Mac. Use the alternate steps as
shown below.

Excel places blue bars on top of your values; long blue bars for larger numbers, shorter ones for smaller numbers. This
makes it easier to see how well each student did in the class – without having to look at the specific numbers.

Another way to apply Data Bars is to:

• Select the range that needs data bars
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Figure 3.19 Data Bars on
the Conditional
Formatting tool

• On the Home tab, in the Styles group, select Data Bars from the Conditional Formatting tool.
• From there you can select data bars of different colors and opacities (see Figure 3.19).

Mac Users: Alternate Steps:

• On the Home tab select Data Bars from the Conditional Formatting tool .
• From there you can select data bars of different colors and opacities (see Figure 3.19).

It is even more important to highlight the students who are failing in the class. To practice further with
Conditional Formatting we will do that in two places, in the Percentages column and on the Letter Grade column. To
start with, we want any F letter grades to be formatted with a light red fill color and dark red text.

1. Select the Letter Grades (R5:R24).
2. On the Home tab, in the Styles group, select Highlight Cell Rules from the Conditional Formatting tool (see Figure

3.20).
3. Select Equal To
4. Fill out the Equal to dialog box so that cells that are equal to: F have Light Red Fill with Dark Red Text (see Figure

3.21).
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Figure 3.20 Conditional
Formatting Equal To

Figure 3.21 Conditional
Formatting Equal To
Dialog Box

Let’s try that one more time – to highlight those students who are passing the class. This time we will use the Pass/Fail
text in the Pass/Fail column. If the text for a student is Pass we want the cell to be formatted with a yellow fill with dark
yellow text.

1. Select the Pass/Fail grades (Q5:Q24).
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Figure 3.22 Conditional
Formatting Custom
Format Cells Dialog box

2. On the Home tab, in the Styles group, select Highlight Cell Rules from the Conditional Formatting tool (see Figure
3.20).

3. Select Equal To
4. Fill out the Equal to dialog box so that cells that are equal to: Pass have Yellow Fill with Dark Yellow Text. (To find

the Yellow Fill with Dark Yellow text option, click the the down arrow at the end of the last (with) box).

You do not have to use the default styles to make your data stand out. You can set any formatting you want. When you
do, it is probably a good idea to include other styling in addition to color. Your spreadsheet might be printed in black and
white. You would hate to lose your Conditional formatting. Now we are going to use conditional formatting to display
any Percentages that are less than 60% with red text formatted in bold and italic.

1. Select the Percentage grades (P5:P24).
2. On the Home tab, in the Styles group, select Highlight Cell Rules from the Conditional Formatting tool (see Figure

3.20).
3. Select Less Than
4. Fill out the Less Than dialog box so that cells that are less than .6 will be have conditional formatting. But, instead

of using the default red text on a light red fill, press the down arrow at the end of that box and select Custom
Format.

5. On the Font tab of the Format Cells dialog box, in the Font style box, select Bold Italic. In the Color box, select Red
(see Figure 3.22).

6. Press OK. Then press OK again.
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Figure 3.23 Conditional
Formatting Manage
Rules

Conditional Formatting is valuable in that it reflects the current data. It changes to reflect changes in the data. To test
this, delete DeShea’s final exam score. (Select N5. Press Delete on your keyboard.) Suddenly, DeShae is failing the course
and the Conditional Formatting reflects that. This is a little unfair to DeShae – who has worked so hard this quarter.
Let’s give him back his grade. Press CTRL Z (Undo). His test score reappears and the Conditional formatting reflects that
as well.

Making Changes

What if you have made a mistake with your Conditional Formatting? Or, you want to delete it altogether? You can use
the Conditional Formatting Manage Rules tool. In our example, we want to remove the conditional formatting rule that
formats the Pass text with yellow. We are also going to modify the minimum passing percentage for the conditional
formatting rule that is applied to the percentages.

1. On the Home Tab, in the Styles Group, select Manage Rules at the very bottom of the Conditional Formatting
drop-down list.

2. Show formatting rules for: This Worksheet (see Figure 3.23).
3. We don’t really need to highlight the students who are passing the class, so select that rule in the Rules Manager

and press the Delete Rule button. Mac Users should click the minus symbol – at bottom left corner to delete
the rule.

In a previous exercise (the IF function), we decided that students were failing if they got a percentage score of less
than 70%, so the Conditional Formatting rule in the Percentage column needs repair.

4. Select the rule that reads Cell Value <0.6.
5. Select the Edit Rule button, and change the .6 to .7 (see Figure 3.24).
6. Click OK (or Apply) twice. Double check that your completed workbook matches Figure 3.25.
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Figure 3.24 Conditional
Formatting Edit
Formatting Rule Dialog
box

Figure 3.25 Completed
Ch3 Gradebook

Setting the Print Area

Before you consider this workbook finished, you need to prepare it for printing. The first thing you will do is set the
Print Area so that the table of Letter Grades in A27:B32 does not print.

1. Select A1:R25. This is the only part of the worksheet that you want to have print.
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2. On the Page Layout ribbon, click the Print Area button. Choose Set Print Area from the menu.

Next you will preview the worksheet in Print Preview to check that the print area setting worked, as well as make sure
it is printing on one page.

1. View the workbook in Print Preview.

Mac Users should choose Print from the File menu to view Print Preview.
2. Set the page orientation to Landscape.
3. Change the page scaling if needed so that the entire worksheet prints on one page.
4. Save the CH3 Gradebook and Parks workbook.

Attribution

3.3 Conditional Formatting by Noreen Brown, Mary Schatz, and Art Schneider, Portland Community College, is licensed
under CC BY 4.0
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8. 3.5 Chapter Practice

Household Budget

Download Data File: PR3 Data
Etta and Lucian Redding are a recently married couple living in Portland, Oregon. Lucian works part time and attends

the local community college. Etta works as a marketing manager at a clothing company in North Portland. They are
trying to decide if they can afford to move to a better apartment, one that is closer to work and school. They want to
use Excel to examine their household budget. They have started their budget spreadsheet, but they need your help with
it.

1. Open the file named PR3 Data and then save it as PR3 Redding.
2. Insert two new rows at the top of the worksheet.
3. Enter the following text:

A2 Category
B2 Item
C2 January
O2 Yearly Total (adjust column width as needed to fit this text)

1. Using the text in cell C2, use Autofill to fill in the months February through December in cells D2:N2. Adjust
column widths as needed to fit the names of the months in these columns.

2. Bold and center align all of the headings in Row 2.
3. Type “Redding Family Budget” in A1. Merge & Center A1:O1. Make this text 22 point bold.
4. Next you need to complete the monthly values for some of the income and expense items. In the rows for Income

#1, Income #2, Mortgage/Rent, Homeowners/Rent Insurance, Car Insurance, Car Payment, and Gym Fees/
Memberships, copy the values for January to the cells for February through December.

5. Use the Totals tab in the Quick Analysis tool to add the SUM to Column O. Delete the formulas from O7, O17, O24,
O32, and O38.

Mac Users should use the AutoSum tool to calculate the totals in Column O. Since you are using the AutoSum
tool, you may not have to delete any formulas in the cells listed in Step 5 above. Also, the Quick Analysis tool will
automatically bold the values in Column O. Mac Users should bold cells O3:O45.

6. In C6: N6, use the SUM function to calculate the Total Income for each month.
7. Similar to step 6, use the SUM function to calculate the Total Home Expenses, Total Daily Living Expenses, Total

Transportation Expenses, Total Entertainment Expenses, and Total Personal Expenses for each month.
8. Use the SUM function to calculate the Yearly Total Personal Expenses in cell O45.
9. Format the numerical data in Row 3 as Currency with no decimal places, and with a top border. Format all the total

rows as Currency with no decimal places and with a top border (Rows 6, 16, 23, 31, 37, and 45).
10. Apply the Comma format with no decimal places in all the other rows.
11. In A47, type “Total Expenses”.
12. In C47, enter a formula that adds together all of the expense category totals for January. Copy the formula in C47

to D47:O47.
13. In A49, type “Net Income”. Bold and indent this text. Also bold C49:N49
14. In C49, enter a formula that calculates the difference between Total Income and Total Expenses (=Total Income-

Total Expenses) for January. Copy this formula to D49:O49.
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15. Format the data in Rows 47 and 49 as Currency with no decimal places. Bold O47 and O49. Add a Top and Double
Bottom Border to the data in Row 49.

16. Select C49:N49. Use the Quick Analysis tool to add data bars to this data. Mac Users should use the
Conditional Formatting tool on the Ribbon. The negative values should automatically have a red data bar and the
positive values will have a blue data bar.

17. In B50, type “New Home?”. Enter an IF statement in C50 that displays the word “No” if the amount in C49 is less
than or equal to zero and “Maybe” if the amount is greater than zero. Copy C50 to D50:N50.

18. Check to see if your IF statement worked correctly in row 50. If the cells say “No” when the data bar in the cell
above it is red and “Maybe” when the data bar in the cell above it is blue, your IF statement is correct.

19. Review the worksheet in Print Preview. Make any changes needed to make the worksheet print on one page with
landscape orientation.

20. Rename the “Sheet 1” sheet tab:

◦ Double-click the “Sheet 1” tab
◦ Type: Budget and press Enter

21. Change the color of the sheet tab:

◦ Right-click the “Budget” sheet tab

◦ Mac Users should hold down the CTRL key and click the Budget sheet tab
◦ Point to “Tab Color”, choose a green color

22. Check the spelling on all of the worksheets and make any necessary changes. Save the PR3 Redding workbook.
23. Compare your work with the self-check answer key below and then submit the PR3 Redding workbook as directed

by your instructor.
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Attribution

“3.5 Chapter Practice” by Diane Shingledecker, Portland Community College is licensed under CC BY 4.0, It is adapted
from Personal Budget Project by Matt Goff, CC BY-SA 4.0.
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9. 3.6 Chapter Scored

MidasCoffee Company

Download Data File: SC3 data
MidasCoffee: Ruth Kobran owns a coffee supply company named MidasCoffee. She needs some help writing the

formulas for the order form she uses to invoice customers. You will need to write the formulas for all of the calculations
on the form. Some of the more complex parts are determining if the customer will get a discount (based on the customer
status) as well as the shipping charge (orders over $199 get free shipping). You will use IF functions for both of those
calculations.

1. Open the SC3 Data workbook and save the workbook as SC3 MidasCoffee.
2. Enter the following order information:

Order #: 56894
Order Date: use a function that displays the current date

3. Enter the following Billing Information:
Samantha Raitt
4270 SW Cooper Ln, Portland, OR 97225
503-674-1632
samantha.raitt@zmail.com

4. For the Shipping Information, create formulas using cell references to display the corresponding information from
the Billing Information section. For example, the Customer cell will display the name of the customer in cell C11.

5. In the range B19:E22, enter the following item orders:

Item # Description Qty Unit Price

K56 Dark Mocha K-Cups (12 pack) 1 11.99

G03 Decaf Dark Roast – Ground (1 lb.) 3 12.99

B07 Organic Dark Roast – Whole Bean (1 lb.) 2 14.99

K52 Chai Latte K-Cups (12 pack) 3 10.99

6. In cell F19, enter an IF function that tests whether the order quantity in cell D19 is greater than 0 (zero). lf it is,
return the value of the Qty (in D19) multiplied by the Unit Price (in E19); otherwise, return no text by entering “”.
Hint: You will need to use a formula for the Value if True argument.

7. Copy/fill this formula into the other cells in the range F19:F25. Hint: be sure to copy the formula to all of the Item
Total cells, even if it is a blank row. You want the worksheet to be prepared for orders with more items in the future.

8. In cell F26, calculate the sum of all of the Item Total cells.
9. In cell F27, use an IF function to calculate the discount amount for this order based on the customer’s status

(which is found in F16). If the customer’s status is Preferred, the discount amount will be the Order Subtotal times
the discount percentage found in cell B29; otherwise the discount amount will be 0 (zero). Hint: You will need to
use a formula for the Value if True argument.

10. Test your IF function to make sure that it still works if the customer is NOT preferred by deleting the word
Preferred in F16. Make sure you do not end up with an error message! If you get an error message, check the IF
function and make the changes needed.

11. Calculate the Discounted Total for this order in cell F28. Hint: Use a simple subtraction formula.
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12. In cell F29, use an IF function to display the correct Shipping Charge, based on the amount of the Discounted
Total. If the Discounted Total is greater than or equal to the Free Shipping Minimum found in cell B28, the Shipping
Charge is 0 (zero); otherwise, the Shipping Charge is 5% of the Discounted Total. Hint: You will need to use a
formula for the Value if False to calculate what 5% of the Discounted Total will be.

13. Calculate the Invoice Total in cell F31. Hint: This will be the total of the Discounted Total and the Shipping Charge.
14. Take a critical look at your worksheet to ensure that all of the number and cell formatting is professional.
15. Review the worksheet in Print Preview. Make any changes needed to make the worksheet print on one page.
16. Check the spelling on all of the worksheets and make any necessary changes. Save the SC3 MidasCoffee workbook.
17. Submit the SC3 Midas Coffee workbook as directed by your instructor.

After reading the advanced section on using Power Tools and creating Macros, complete the next section:
18. Reopen the SC3 Midas Coffee assessment. Apply a Power Tool of your choice to the assessment. Include your

rationale for using this tool for your assessment. Save it as Assessment 3B with your name and turn it in as directed by
your instructor.

19. Reopen the SC3 Midas Coffee assessment. Record a macro that changes the item numbers to the color red.

Attribution

“3.6 Chapter Scored” by Noreen Brown, Art Schneider and Mary Schatz and Jennifer Evans, Portland Community College
is licensed under CC BY 4.0
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PART IV

CHAPTER 4 – PRESENTING DATA WITH CHARTS

One of the most important things to consider when using charts in Excel is that they are intended to be used for
communicating an idea to an audience. Your audience can be reading your charts in a written document or listening to
you in a live presentation. In fact, Excel charts are often imported or pasted into Word documents or PowerPoint slides,
which serve this very purpose of communicating ideas to an audience. Although there are no rules set in stone for using
specific charts for certain data types, some chart types are designed to communicate certain messages better than
others. This chapter explores numerous charts that can be used for a variety of purposes. In addition, we will examine
formatting charts and using those charts in Word and PowerPoint documents.

Attribution

Adapted by Hallie Puncochar and Noreen Brown from How to Use Microsoft Excel: The Careers in Practice
Series, adapted by The Saylor Foundation without attribution as requested by the work’s original creator or licensee, and
licensed under CC BY-NC-SA 3.0.
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10. 4.5 Chapter Practice

To assess your understanding of the material covered in the chapter, please complete the following assignments.
Although Excel is primarily used in business and scientific applications, you will find it useful in other areas of study

as well. In these exercises, we will use Excel to create charts using historical, and health data.

Charting Historical Data (Comprehensive Review)

Download Data File: PR4 Data
Excel is an excellent tool for helping display historical data. In this exercise, we will be examining ways to display

information on minimum mage data and life expectancy.

Task1 – National Minimum Wages Changes in The United States 2019-2020

Since the beginning of the previous century, the United States has set a minimum wage, in order to set a “floor” beneath
which wages cannot fall. Most states have set their own minimum wages, but none are lower than the national minimum
wage. Follow the below steps to insert a Map Chart outlining what the current minimum wage is per state.

1. Open the file named PR4 Data and then Save As PR4 Historical Data.
2. On the Minimum Wage worksheet, select the range B4:B55. Press and hold the CTRL key and select

D4:D55.

Mac Users: hold down the “Command” key not the CTRL key
3. Select the Insert tab, then the Map Chart tool in the Charts group.
4. Move the Chart as a New Sheet. Rename the sheet Map.
5. Update the Chart Title to US Minimum Wage 2020.
6. From the Charts Element menu choose to display the Data Labels.
7. From the Charts Element menu, turn off the Legend.
8. Prepare the Minimum Wage worksheet for printing by changing the scaling to Fit Sheet on One Page.
9. Save your work.
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Figure 4.32 Map Chart

TASK 2 – OREGON: PROJECTED LIFE EXPECTANCY AT BIRTH

In the past 40 years, between 1970 and 2010, life expectancy for Oregon men improved by 8.7 years and for women by
5.5 years. Oregon’s life expectancy has remained slightly higher than the U.S. average. The life expectancy will continue
to improve for both men and women. However, the gain for men has been outpacing the gain for women. Consequently,
the difference between men’s and women’s life expectancies has continued to shrink.

https://www.oregon.gov/das/OEA/Documents/OR_pop_trend2012.pdf
1. On the Life Expectancy sheet, select A5:B11.
2. From the Insert tab choose Recommend Charts. Select the second option, Clustered Column chart.
3. Move the chart to a new sheet. Name the sheet Men.
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Figure 4.33 Male Bar Chart Solution

4. Repeat steps above to create a matching chart for Life Expectancy for Oregon Women, by selecting A5:A11.
Press and hold the CTRL key and select C5:C11.

Mac Users hold down the Command key
5. Use the Recommended Charts and select the Clustered Column chart.
6. Move the chart to a new sheet. Name the sheet Women.
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Figure 4.34 Female Bar Chart

7. Notice on the men’s and women’s vertical axis the min and maximum bounds do not match. To ensure data
is comparable, adjust the min and max bounds of both the Mens and Womens chart to chart to match:

Figure 4.35 Axis Bounds
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8. Return to the Life Expectancy tab, select A5:D11.
9. Use the Recommended Charts tool to create a

simple line chart.
10. Change the Chart Title to Oregon: Projected Life

Expectancy at Birth.
11. Leave the chart embedded in the worksheet. Move

and resize it accordingly.
12. The line across the bottom of the chart represents

the difference between men’s and women’s life
expectancy. It is not very helpful as it is. Right-click on
the line to open the pop-up menu. Select Format Data

Series. In the Format Data Series pane, under the Series Options tab, select the radio button in front of
Secondary Axis.

Mac Users should hold down the CTRL key and click the line at the bottom.
Select Format Data Series. In the Format Data Series pane, under the Series Options tab, select the radio
button in front of Secondary Axis.

13. Close the Format Data Series pane.
14. Use the Chart Styles tools to change your chart to something a bit more dramatic.
15. Preview the Life Expectancy worksheet in Print Preview and make any necessary changes. The solutions

are shown in below in Figure 4.35.
16. Check the spelling on all of the worksheets and make any necessary changes. Save the PR4 Historical

Data workbook.
17. Submit the PR4 Historical Data workbook as directed by your instructor.
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Figure 4.36 Projected Life Expectancy Line Chart

Attribution

“4.5 Chapter Practice” by Hallie Puncochar and Noreen Brown, Portland Community College is licensed under CC BY 4.0
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11. 4.6 Scored Assessment

Charting Sales Data

Download Data File: SC4 Data
An effective way to communicate findings in Excel is by graphing data. Graph the attached sales information,

visualizing profit margin trends, and production patterns, and the sales pipeline; enabling decision-makers to grasp
concepts of current business practices.

Task 1 Revenue & Profit Margin

Following the directions below create the below charts. Note to match each chart exactly, including the chart styles,
and axis bounds.

1. Open the file named SC4 Data and then Save As SC4 Sales.
2. From the Revenue & Profit Margin sheet, create the below Combination Chart.
3. Move the chart to a new sheet. Name the sheet Combo.
4. Save your work.
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Figure 4.36 Combination Chart

Task 2 Quartly Production Data

Create the below Pie Chart showing how many locations will be producing products in the North, South, East and West
Regions.

1. From the Products sheet create the below chart.
2. Move the chart to a new sheet. Name the sheet Doughnut.
3. Save your work.
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Figure 4.37 Doughnut Chart

Task 3 Sales Pipeline

Create the below Funnel Chart to provide our sales team a visual snapshot of the company’s sales process, outlining
deals that are expected to close within the month.

1. From the Sales sheet, create the below Funnel Chart.
2. Note to leave the chart embedded in the sheet. Resize, and move the chart accordingly.
3. Check the spelling on all of the worksheets and make any necessary changes. Save your work and submit SC4

Sales as directed by your instructor.
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Figure 4.38 Funnel Chart

Attribution

“4.6 Scored Assessment” by Hallie Puncochar, Portland Community College is licensed under CC BY 4.0
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PART V

CHAPTER 5 – TABLES

Excel is the leading application for storing, managing and analyzing data. In Chapter 5, you will explore how to import,
organize, and analyze data effectively. To manage and analyze a group of related data, users can turn a range of cells into
an Excel table.

A table, also called a database, is an organized structure of rows and columns of related data in a worksheet; for
example, a list of employee information. In a table of employees, each employee would have a separate record; as shown
below, each record might include several fields, such as the Employee ID Number, their Last Name, and First Name, etc.
Each row of a table stores records, and each column stores one field for the record. A record also can include fields that
contain references, formulas, and functions. Additionally, a row of column headings at the top of the table stores field
names that identify the data being collected and stored.

Excel has a vast collection of database and tabling tools that allow users to import, clean, sort, filter, total, subtotal,
analyze, visualize, and report. This chapter explores how to import, insert, edit, and examine data with Excel table
and PivotTable tools. Demonstrate skills by studying the provided 2017-2018 employee database. Examine employee
relations, payroll, benefits, and training options.

Attribution

Chapter 5 – Tables by Hallie Puncochar, Portland Community College is licensed under CC BY 4.0
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12. 5.4 Chapter Practice

Tables for a Tourism Company

Download Data File: PR5 Data

Travel and tour companies need to keep track of client data, as well as, travel/tour options and tour guides. Keeping up-
to-date, accurate records is essential to their bottom line. To run a tour company, employees must be able to manipulate
their data quickly and easily. This exercise illustrates how to use the skills presented in this chapter to generate the data
needed on a daily basis by a tourism company.

1. Open the data file PR5 Data and save the file to your computer as PR5 Canyon Trails.
2. Click Sheet 1. Choose cell B3.
3. From the Home tab, choose Format as Table. Choose the Orange, Table Style Medium 3.
4. In J4, calculate Total Cost (number of Guests *Per Person Cost). Note Excel will add the formula to the

entire column. (If prompted, choose to overwrite the formula to the cells below.)
5. Format Columns I and J with Accounting format, no decimal places.
6. Center all headings in Row 3.
7. Adjust column widths within the table so that all the headings are completely visible.
8. Rename Sheet 1 Current Tours. Sort this sheet alphabetically (A to Z) by Last Name.

Figure 5.70 Current Tours
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9. Make a copy of the Current Tours sheet and rename it Tours by Canyon. One way to make a copy of a

worksheet is to right-click on the worksheet tab ( Mac Users: Ctrl+click) and select Move or Copy. Be sure to
check the Create a Copy box. Place the Tours by Canyon sheet to the right of the Current Tours sheet.

10. Sort the Tours by Canyon sheet by Tour Canyon, Home Country, and then Last Name all in Ascending
order (A to Z).

Figure 5.71 Tours by Canyon

11. Make another copy of the Current Tours sheet and rename it US Guests. Place the US Guests sheet to the
right of the Tours by Canyon sheet.

12. Filter the US Guests sheet to display customers who live in the United States. Sort the filtered data
alphabetically (A to Z) by Tour State. Add a Total Row that sums the Guests and Total Cost columns.
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Figure 5.72 US Guests

13. Make another copy of the Current Tours sheet and rename it, European Guests. Place the European Guests
sheet to the right of the US Guests sheet.

14. Insert a slicer in the European Guests sheet for Home Country. Move the top left corner of the slicer to the
top left-hand corner of cell L3. Resize the slicer so all buttons display. Format the slicer to match the table.

15. Using the slicer, filter the data to display customers from Germany and the United Kingdom.
16. Sort the filtered data by the Home Country, and Last Name fields displaying both in Ascending order (A to

Z).

Figure 5.73 European Guests

17. Click the Advanced Filter sheet. Using the Advanced Filter option, filter the Current Tours table based on
the criteria given. Determine how many guests from Canada are taking tours in Arizona and Utah between the
costs indicated in the criteria table. Place the results in A10.
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18. Turn the results into a table. Format the table to match the criteria area. Turn on the total row and show
the Sum of the Total Cost column.

Figure 5.74 Advanced Filter

19. Select the Current Tours sheet. Click in the table area and insert a PivotTable as a new sheet. Name the
sheet ToursPT. Run a report to show the Total Cost per Home Country, for each available Tour States. Format
the numbers in currency format, zero decimal places. Choose a PivotStyle format to match the current orange
theme.

Figure 5.75 ToursPT

20. Make one more copy of the Current Tours sheet and rename it Tours by State. Place the Tours by State
sheet to the right of the European Guests sheet. Go to the Table Tools and turn off the Banded Rows.

21. Subtotal the data by State, summing the Total Cost column. (Note: Remember to follow the four rules of
subtotaling!)

22. After you subtotal, turn on filters and filter out 3-day tours in the table.
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Figure 5.76 Subtotal

23. On each worksheet, make the following print setup changes:
a) Add a footer with the current date, worksheet name, and your name.
b) Change to Landscape Orientation
c) Set the scaling to Fit All Columns on One Page
d) For any worksheets that print on more than one page, add Print Titles to repeat the first three rows

at the top of each page.
24. Check the spelling on all of the worksheets and make any necessary changes. Save the PR5 Canyon Trails

workbook. Submit the PR5 Canyon Trails workbook as directed by your instructor.

Attribution

“5.4 Chapter Practice” by Hallie Puncochar and Diane Shingledecker, Portland Community College is licensed under CC
BY 4.0

“Canyon Trails Data File” by Matt Goff is licensed under CC BY 3.0
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13. 5.5 Scored Assessment

Tables for a Retail Company

Download Data File: SC5 Data
Retail companies with today’s online, as well as, in-store sales have a lot of data to keep track of! Keeping track of

sales, costs, and profits on a daily basis is essential to making the most of a business. This exercise illustrates how to use
the skills presented in this chapter to generate the data needed on a daily basis by a retail company.

1. Open the data file SC5 Data and save the file to your computer as SC5 Dynamite Customer Sales.
2. Click the Sales Sheet. Format the data set as a table. Choose a style from the styles gallery.
3. Create the following calculated columns.

a) In I4, and J4, use a VLOOKUP function that will look up the Product Price and Product Cost based
on the Product Sold column which lists an ID number. [Hint: The Product Table sheet lists the Price and
Cost] If any error messages appear, check the Range Lookup.

b) In K4, use a formula to calculate Profit. Hint: Profit =(Product
Price-Product Cost)*Units Sold

4. Format columns I, J, and K as currency with two decimal places.

5. Make a copy of the Sales sheet and rename it Online Sales by Date.
Place this sheet to the right of the Sales sheet. Answer the following
question by filtering the data accordingly. What was the total Profit for
Online Sales? Sort the results by Date Sold (A/Z).

6. Make a copy of the Sales sheet and rename it June Sales by Country. Place this new sheet to the right of
the Online Sales by Date sheet. Answer the following question by filtering the data accordingly. In June, for all
products sold, what was the total profit earned? Sort the results by Country, then Name both in (A/Z).

7. Make another copy of the Sales sheet and rename it Sales by Product. Place this new sheet to the right of
the June Sales by Country sheet. Using a slicer, filter the data accordingly to display the average Product Price,
Product Cost, and Profit for DETA100 and DETA200 items. Sort the filtered sheet by Product Sold. [Hint: In the
total row make sure to type the word Average in column A.]

8. Make one final copy of the Sales sheet and rename it Subtotals by
Sales Type. Place this new sheet to the right of the Sales by Product
sheet. Subtotal the sheet by Sales Type, summing the Profit column.

9. Add a 2nd subtotal to the Subtotals by Type sheet that subtotals by Sales Type and averages the Profit
column.

10. From the Sales sheet, create the below PivotTable totaling per product type the Product Cost for Online
and Retail sales. Insert the PivotTable as a new sheet. Name the sheet ProductPT.
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Figure 5.77 ProductPT

11. For each worksheet, add a footer with the worksheet name in the center and your name in the right panel.
12. Preview each worksheet in Print Preview and make any necessary changes for professional printing. (Hint:

Orientation, page scaling, and print titles might need to be used.)
13. Check the spelling on all of the worksheets and make any necessary changes. Save the SC5 Dynamite

Customer Sales workbook, and submit the file as directed by your instructor.

Attribution

“5.5 Scored Assessment” by Hallie Puncochar and Diane Shingledecker, Portland Community College is licensed under
CC BY 4.0
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PART VI

CHAPTER 6 – MULTIPLE SHEET FILES

Excel workbooks often contain a large amount of data, and worksheets can quickly become overwhelming. When one
worksheet becomes cumbersome, data can be broken out into smaller subsets and placed in separate worksheets within
the same Excel file. Separating out spreadsheet data into smaller pieces can lead to better data organization within a
file and increase its ease of use. When a retail company needs to track overall sales, as well as, individual store sales, it
makes sense to place each store’s sales data in a separate sheet within a file. Adding a summary sheet that sums across
all the sheets will allow for total company sales data in the same file. This chapter will show how to set up a workbook
to make multi-sheet formulas quick and easy.

Other examples of when multiple sheets make the most sense are when you are comparing regional data for a
salesforce and wish to evaluate individual salesperson performance along with overall sales, and data over a period of
time where sheets can be broken out by year or by month. When comparing data across several sheets, it is essential
that all the sheets are laid out in the same way. To facilitate this, a template can be used. A template is the basic pattern
for each new sheet that can be used repeatedly to make sure each new sheet has the same setup, formatting, formulas,
etc. as the existing sheets in a file. In this chapter, we will use both pre-made, Microsoft Excel templates, as well as, ones
we will create from scratch to meet the specific needs of our work.

Attribution

Chapter 6 – Multiple Sheet Files by Mary Schatz and Diane Shingledecker, Portland Community College is licensed
under CC BY 4.0
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Figure 6.1 Personal
Budget File

14. 6.1 Multiple Sheet Basics

Learning Objectives

1. Navigating through a multiple sheet file.
2. Adding, deleting, copying, and moving sheets.
3. Grouping and ungrouping sheets.

Throughout our textbook, we have worked with Excel files that have included multiple sheets. Depending on the version
of Excel you are using, a new Excel file may start with one or several sheets. In this chapter, we will be working with
a personal budget file that contains income and expenses for an entire year. Our file contains a sheet for each month
of the year, as well as, a Summary sheet that will add all twelve monthly sheets of data together. To begin with, we’ll
get comfortable with moving through the sheets, organizing them, and making sure that all twelve monthly sheets are
consistent.

Figure 6.1 shows the January sheet in the Personal Budget file along with all the sheet tabs along the bottom of the
window.

Navigating Through a Multiple Sheet File

Download Data file: CH6 Data
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1. Open the data file CH6 Data and save the file to your computer as CH6 Personal Budget. Notice that the file has an
Expenses Summary sheet at the far left followed by monthly sheets.

2. Click on the different sheets at the bottom of the screen to move through the sheets. Notice that the Expenses
Summary sheet is formatted differently from the monthly sheets. Notice also that all the monthly sheets are identical in
layout and format.

3. Take a second look at the months at the end of the year. Not all the data has been entered for September through
November… and there is no sheet for December. We will enter the remaining data and add an additional sheet for
December.

4. Add the following data in the September, October, and November sheets:

September October November

Power $135 $135 $135

Water $30 $30 $30

Groceries $300 $325 $400

Miscellaneous $100 $50 $100

Bonus

Freelance $500 $150

Other $100

Copying a Sheet

1. To make a December sheet, we are going to copy the November sheet.
2. Point your mouse at the November sheet tab at the bottom of the screen.
3. Hold down your left mouse button and then press and hold down the CTRL key.

Mac Users: hold down your left button while pointing at the November sheet tab and then press and hold
down the Option (alt) key

4. At this point, you will see a black down-pointing arrow to the left of the November sheet tab and your mouse
cursor will become a small piece of paper with a plus sign on it.

5. Drag your mouse to the right (still holding down the left-mouse button and the CTRL key) until the black down-
pointing arrow is to the right of the November sheet tab.

6. Let go of the mouse button and then the CTRL key. You should now have a November (2) sheet to the right of the
November sheet as shown in Figure 6.2.
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Figure 6.2 Additional
November Sheet

Next, we’ll update the November (2) sheet to turn it into our December sheet.

1. Right-click on the November (2) sheet name at the bottom of the screen and choose Rename.

Mac Users: hold down the Ctrl key and click the November (2) sheet name. Choose Rename
2. Type “December” and press Enter.

Note for all users: you can also double-click a sheet tab name to rename it.
3. Click on the December sheet.
4. Click on B1 and change “November” to “December”. Be careful not to click on the “Monthly Budget” image.
5. Make the following data changes:

◦ Miscellaneous: $300
◦ Bonus: $250 (it’s the holidays!)
◦ Freelance: delete amount

6. Save your work.
7. Point your mouse at the December sheet tab at the bottom of the screen.

8. Hold down your left mouse button and then press and hold down the CTRL key ( Mac Users hold down Option
key)

9. Drag your mouse to the right (still holding down the left-mouse button and the CTRL key) until the black down-
pointing arrow is to the right of the December sheet.
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10. Let go of the mouse button and then the CTRL key. You should now have a December (2) sheet to the right of the
December sheet.

11. Rename the December(2) sheet Practice.

Skill Refresher

Copying a Sheet

1. Point your mouse at the sheet you want to copy at the bottom of the screen.

2. Hold down your left mouse button and then press and hold down the CTRL key ( Mac Users hold
down the Option key)

3. Drag your mouse to the right (still holding down the left-mouse button and the CTRL key) until the
black down-pointing arrow is to the right of your existing sheet.

4. Let go of the mouse button and then the CTRL key. You should now have a Sheetname (2) to the right
of the original sheet.

5. Rename the Sheetname (2) sheet as desired.

Moving and Deleting Sheets

Sometimes your sheets do not end up in the right order, and you need to move them in order to fix this. Let’s try moving
our “Practice” sheet to see how this is done.

1. Point to the Practice sheet and hold down your left mouse button.
2. Notice this time that there is still a black arrow to the left of the Practice sheet, but the piece of paper is blank. It

does not have a plus sign (+) because we are moving, instead of copying, the sheet.
3. Left-drag the mouse to the left until the black arrow marker is between the October and November sheets.
4. Release the mouse button.
5. Try moving the Practice sheet back to the right of the December sheet.

Since our Practice sheet is not a sheet we will need in our Budget file, we’ll go ahead and delete it now.

1. Right-click on the Practice sheet tab at the bottom of the screen.

Mac Users hold down the Ctrl key and click the Practice sheet tab
2. Click Delete. Figure 6.3 shows the warning message box that will appear on your screen. Your message box might

look slightly different depending on the version of Excel you are using. It is important to note that you cannot
Undo once you delete a sheet!
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Figure 6.3 Warning
Message Box

3. Click Delete.

Grouping and Ungrouping Sheets

Take a look at the monthly sheets again. Notice that there is a place in each of these sheets in the range F11:F13 to
calculate three pieces of Summary data: Income, Expenses, and Balance; but there aren’t any formulas in these cells.
There is also a place for the % of Income Spent (in cell I5), but we will need to add a formula in I6:I7 to calculate this.
If we entered these formulas individually in each of the 12 month sheets, it would take a long time! Because this task
would be very repetitive, it would also be fairly likely that we would make some mistakes along the way entering the
same formulas over and over again. By grouping all the month sheets together, we can enter each of the formulas once
and have them appear in all the sheets.

1. Click on the January sheet to make it active.
2. Hold the SHIFT key down and click on the December sheet.

Now all 12 sheets should be selected. You can tell this in two ways: the sheet tabs that have been selected are now bold at
the bottom of your screen. Also, notice in the Title bar at the top of the screen the word [Group] or – Group (depending
on your version of Excel) added to the end of the title. You can see both of these in Figure 6.4.
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Figure 6.4 Grouped
Sheets

IT IS IMPORTANT TO REMEMBER THAT ANY CHANGES WE MAKE TO THE JANUARY SHEET WILL BE MADE TO ALL
THE SHEETS!! This is a very good thing when we want to make changes to all the sheets at once, but we need to be sure
to ungroup them when we’re done making these changes. Let’s go ahead and add the formulas to all twelve of the sheets
at once:

1. Click in F11 in the January grouped sheet.
2. Enter the formula =SUM(F5:F8).
3. In F12, enter the formula =SUM(C5:C13).
4. In F13, subtract Expenses from Income. In the January sheet, your balance should be $690. HINT: if your answer is

negative, you subtracted Income from Expenses.
5. Click on I6. (I6 and I7 are formatted and merged together – this is fine.)
6. Enter a formula that divides Expenses (F12) by Income (F11). Your answer will show as a percentage since this cell

has already been formatted to do this. HINT: If you percentage is greater than 100%, you have your numbers
reversed.

Notice that a data bar was set up in I5 to visually show the income spent. Do you remember how to do this from earlier
in our textbook? Your January sheet should now look like Figure 6.5.
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Figure 6.5 January Sheet
with Formulas

Figure 6.6 December
Sheet with Formulas

7. Now that we are done making changes to all the monthly sheets at once, we need to ungroup them. Right-click on one
of the grouped sheets and choose Ungroup Sheets.

Mac Users hold down Ctrl key click on one of the grouped sheets and
choose Ungroup Sheets.

Notice the sheets tabs are no longer bold and the word [Group] is no longer in the title bar.
8. Click on several of the month sheets to see that all the formulas have been added.
9. Click on the December sheet. Your sheet should now look like Figure 6.6.
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1. Take a look at the Notes in the September sheet. It says that the rent was raised in September, so we need to
cancel our Gym Membership and show $0 for the Gym amount in October, November, and December.

2. Group the October, November, and December sheets. If you do this successfully, these three sheet names should
be bold and the word [Group] or – Group will appear in the Title bar.

3. Click on C13 and change the amount to $0. Press Enter.
4. Ungroup the sheets. The balances should be: October $605, November $530, and December $430.

Skill Refresher

To Group Sheets:
Click on the leftmost sheet you want to group; then hold the SHIFT key down and click on the rightmost sheet

you want to group. Same for Excel for Mac.

To Ungroup Sheets:
Right-click on one of the grouped sheets and choose Ungroup Sheets.

Mac Users hold down Ctrl key click on one of the grouped sheets
and choose Ungroup Sheets.

Key Takeaways

• You can easily move, copy, delete, and rename sheets in your Excel file.
• Grouping sheets allows you to change a group of identically formatted sheets at the same time.

Attribution

“6.1 Multiple Sheet Basics” by Mary Schatz and Diane Shingledecker, Portland Community College is licensed under CC
BY 4.0
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15. 6.2 Formulas with 3-D References

Learning Objectives

• Entering formulas that reference another sheet.
• Using the SUM function to add up multiple sheets.

The Summary sheet in many multiple sheet workbooks is utilized to present totaled information from the other sheets
in the file. This is done to give a quick synopsis of all the other sheets in one convenient location. For this reason, the
Summary sheet is usually the first sheet in multiple sheet files. Summary sheets “pull” data from the other sheets using
three-dimensional (3-D) cell references. In order to distinguish between A3 in the Summary sheet, A3 in the January
sheet, A3 in the February sheet, etc.; a 3-D cell reference includes the sheet name along with the cell reference. The
syntax to reference a cell in a different sheet is =SheetName!CellRange. So, the cell reference for A15 in the March sheet
would be =March!A15.

Let’s start working on our summary sheet by trying out some 3-D formulas:

1. Click on the Expenses Summary sheet tab at the bottom of the screen.
2. Click on C5 and enter the formula =January!C5. Press Enter.

This will return the amount $700 from cell C5 in the January sheet.
3. Delete the formula in C5 in the Expenses Summary sheet.
4. This time, click on C5 and type =. Then click on the January sheet, and then click on C5.
5. Press Enter. This will put the same formula, =January!C5, in cell C5 in the Expenses Summary sheet and will return

the value $700. This is the point and click method. This method reduces the potential for making errors, such as
misspellings or typing the wrong amount.

6. In cell C6 in the Expenses Summary sheet, try entering a formula for the Power amount in the April sheet. You
should get $135 as the Power amount, and the formula should be =April!C6.

7. Delete the formulas in cells C5 and C6 in the Expenses Summary sheet.

For the Annual Amounts in C5:C13 in the Expenses Summary sheet, we don’t need the amount from a single month’s
sheets; instead, we need the sum of all the entries in all the monthly sheets. So, we need to sum three-dimensionally
through all twelve month sheets.

Let’s try adding up all the monthly amounts in our Expenses Summary sheet:

1. Click in C5 in the Expenses Summary sheet.
2. Type =SUM(. (Make sure to type the open parentheses!)
3. Click on the January sheet.
4. Hold the SHIFT key down and click on the December sheet.
5. Click on C5 again and press ENTER. Cell C5 should display the sum amount of $8,400.
6. Click on C5 in the Expenses Summary sheet. In the formula bar, you should see the following formula:

=SUM(January:December!C5). This formula tells Excel to SUM cell C5 in the sheets January through December.
7. Let’s try another 3-D SUM together. Click on C6.
8. Type =SUM(. (Make sure to type the open parentheses!)
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Figure 6.7 Complete
Expenses Summary
Formulas

9. Click on the January sheet.
10. Hold the SHIFT key down and click on the December sheet.
11. Click on C6 again and press ENTER. Cell C6 should now display the sum amount of $1,610.
12. Click on C6 in the Expenses Summary sheet. In the formula bar, you should see the following formula:

=SUM(January:December!C6).

If you feel comfortable with these 3-D formulas, you can copy C6 down through C13 to fill in the rest of the formulas. If
you’re not quite comfortable yet, keep practicing the above steps to add 3-D formulas to cells C7:C13. When you’re done,
your Expenses Summary sheet should match Figure 6.7.

While our 3-D formulas are complete in the Expenses Summary sheet, our summary feels like it is lacking something.
Let’s add a visual representation of our summary numbers to the sheet.

1. Highlight cells B5:C13 in the Expenses Summary sheet.
2. Click on Pie Chart in the Insert tab in the ribbon and select the 2-D pie.
3. Move and resize the pie chart so that it fills cells D3:J15.
4. Delete the chart title.
5. Move the legend to the right side of the chart. Resize the legend as needed.
6. Add percentage data labels to the pie slices. Format the data labels to be bold with white font color. Your complete

Expenses Summary sheet should look like Figure 6.8 below.
7. Check the spelling on all of the worksheets and make any necessary changes.
8. Save your file. If you’re printing your assignment at this point, print ONLY the Summary sheet in regular and

formula view. Close your file.
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Figure 6.8 Completed
Expenses Summary
Sheet

Skill Refresher

To SUM across sheets:

1. Click on the cell where you want the 3-D SUM to appear.
2. Type =SUM(
3. Click on the leftmost sheet in the group of sheets you want to sum.
4. Hold the SHIFT key down and click on the rightmost sheet in the group of sheets you want to sum.
5. Click on the cell in the sheet you’re in that you want to sum.
6. Press ENTER.

Skill Refresher

3-D References in Formulas

To reference a cell in another sheet, use the formula syntax =SheetName!CellAddress.

To enter a 3-D reference:

1. Click on the cell where you want the formula to appear and type =.
2. Click on the sheet with the cell you want.
3. Click on the cell in the sheet you want and press ENTER.
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Key Takeaways

• 3-D references in formulas allow you to use data from one or more sheets on another sheet.

Attribution

“6.2 Formulas with 3-D References” by Mary Schatz and Diane Shingledecker, Portland Community College is licensed
under CC BY 4.0
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Figure 6.9 New Template
Screen in Backstage
View

16. 6.3 Templates

Learning Objectives

1. Use existing Microsoft Excel templates to create new spreadsheets.

A template is a predefined pattern for a spreadsheet that has already been created for you. Hundreds of templates,
already created by Microsoft, are available for you to use in Excel. These templates are very helpful if you have limited
time to get a new task done in Excel, and you don’t know where to start. Templates do a lot of the work for you!
Templates include all the formulas, formatting, etc. needed in a professional Excel spreadsheet. All that’s left to do is
enter the data. Predefined Microsoft templates include everything from billing statements to blood pressure trackers to
business cards. Depending on your version of Excel or Office 365, template categories may include: Business, Personal,
Planners and Trackers, Lists, Budgets, Charts, and Calendars. In this chapter we will explore using existing Microsoft
templates.

To access the templates in Excel, do the following:

1. Click the File tab in the ribbon.

2. Click New in Backstage View. Mac Users: Click the File menu option and choose New from Template
3. The top of your screen should look similar to Figure 6.9. If you have opened templates previously, these may show

in this screen as well.

In the Search for online templates box shown above, you can type a description for the template you want to use. Let’s
start by searching for a Travel Expense Report.

1. Click in the Search for online templates box.
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Figure 6.10 Travel
Expenses Report
Template

2. Type Travel Expense and press ENTER.
3. Click on the Travel Expense Report that looks like Figure 6.10 below and click Create. NOTE: If this template is

not available, select a similar one.

Your screen should look similar to Figure 6.10 below. Notice the design, layout, and formulas have already been set up
for you.

Try using this template by doing the following:

1. Change the Name to your name.
2. Change the Department to Technology.
3. Hold down CTRL and click ~ to see where the formulas are in the sheet. Working in formula view helps you see

where the formulas are, so you won’t delete them.
4. In formula view, carefully delete just the data, including the Description of Expense and the dollar amounts. Don’t

delete any formulas!
5. Hold down CTRL and click ~ again to return to Normal view.
6. Enter Dates, Descriptions and expenses for a trip of your imagining in the first three rows under the column

headings.
7. Save the completed file as CH6 Travel Expenses. Close the file.

We will practice using one more Excel template to create a class schedule. If you already know your schedule for next
term, you can use it to complete this template. Otherwise, use your current class schedule.

1. Click the File tab in the ribbon.

2. Click New in Backstage View. Mac Users: Click the File menu option and choose New from Template
3. Click in the Search for online templates box.
4. Type Class Schedule and press Enter.
5. Click on the Student schedule that looks like Figure 6.11 below and click Create. NOTE: If this template is not

available, select a similar one.
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Figure 6.11 Class
Schedule Template

6. Click on the Class List sheet. Replace the information in the Class, ID, Day, Location, Start Time and End Time
columns with your own class schedule. In the Day column, use the dropdown arrow in the lower right corner of
the cell to select the day of the week.

7. Click back on the Class Schedule sheet to view your completed schedule. Click in cell H2, then click the dropdown
arrow in the lower right corner and select 60 MIN for the Time Interval.

8. Save the completed file as CH6 Class Schedule. Close the file.

Skills Refresher

To use a Microsoft predefined template:

1. Click on the File tab in the ribbon.
2. Click on New

Mac Users: Click the File option and choose New from Template
3. Type the desired template description in the Search box, and press ENTER.

Key Takeaway

• There are many pre-designed templates in Excel developed in Excel that you can use. This will save
you the time and effort of designing and creating these files from scratch.

6.3 Templates | 89



Attribution

“6.3 Templates” by Mary Schatz and Diane Shingledecker, Portland Community College is licensed under CC BY 4.0

90 | 6.3 Templates



17. 6.4 Preparing to Print

Learning Objectives

1. Printing all of the worksheets in a workbook at one time.
2. Preparing multiple worksheets for printing using grouping.

Just like consistency in formatting is important when working with workbooks containing multiple worksheets with
the same type of data, so is consistency in page setup. Now that the CH6 Personal Budget workbook is complete, you
are going to prepare it for printing by changing the page orientation and adding a header. You will also print all 13
worksheets at one time.

Applying Page Setup Options to Grouped Worksheets

Data file: Continue with CH6 Personal Budget.
As always, you need to review your workbook in Print Preview before considering it complete. When you do that

with this workbook, you notice that the worksheets are each printing on two pages. You decide to switch all the
worksheets to Landscape orientation to see if that helps. You will also add a footer with the worksheet name to each of
the worksheets.

1. Go to Print Preview. To view all of the worksheets at one time, select Print Entire Workbook in the first box in the
Settings section. You should now have 26 pages to scroll through in Print Preview. If you were to click the Print
button, all of the worksheets would print, not just the active sheet.

2. Exit Backstage View. You want to change the page orientation of all the sheets, but you cannot change all of them
at one time in Print Preview.

3. Group all of the worksheets together, including the Expenses Summary sheet through the December sheet.
4. Click on the Page Layout tab on the ribbon, then select Landscape using the Orientation button in the Page Setup

group.
5. Click the Page Setup dialog box launcher arrow in the Page Setup group then click the Header/Footer tab.

Mac Users: Click the Page Setup button (there are no “dialog box launcher arrows) in Excel for Mac
6. Click the Custom Footer button. In the center section, insert the sheet name using the Insert Sheet Name button.

The Footer dialog box should look like Figure 6.12.
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Figure 6.12 Insert
Worksheet Name

Figure 6.13 Scale to Fit

7. Click OK to close the Footer dialog box. Click OK again to close the Page Setup dialog box.
8. Return to Print Preview to confirm that each worksheet is printing on one page, in landscape orientation, with the

correct worksheet name appearing in the footer.

Mac Users: the monthly sheets may still show as printing on multiple pages. If that is the case, close Print
Preview, make sure all of the sheets are still grouped, click the Page Layout tab, click the Page Setup button, and
click the Fit to scaling option. It should show “1 pgs wide by 1 tall”. Then click OK.

In Print Preview you notice that the Expenses Summary sheet is not set to print correctly. Part of the chart is appearing
on a second page. You can easily fix this by changing the Scaling, but you only want to change the scaling of the Expenses
Summary sheet, not the entire workbook. If you make the change in Print Preview while the worksheets are grouped it
will change all of the worksheets.

Mac Users can skip steps 1-7 below. You should see in Print Preview that all sheets are now displaying on
one page including the Expenses Summary sheet. Continue with Step 8 below.

1. Exit Backstage View.
2. Ungroup the worksheets by right-clicking on any of the worksheet tabs and selecting Ungroup Sheets.
3. If needed, click on the Expenses Summary worksheet tab to make it the active worksheet.
4. Click on the Page Layout tab on the ribbon and locate the Scale to Fit group of commands. (See Figure 6.13.)

5. Click the drop-down arrow for Width: and select 1 page. This has the same result as selecting Fit All Columns on
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One Page in the Scaling setting in Print Preview.
6. Return to Print Preview to confirm that the Expenses Summary worksheet is now printing on one page only.
7. Exit Backstage View.
8. Save the CH6 Personal Budget workbook.
9. Submit the following files as directed by your instructor.

• CH6 Personal Budget
• CH6 Travel Expenses
• CH6 Class Schedule

Key Takeaways

• To print all of the worksheets in a workbook at one time select Print Entire Workbook in the Print
Settings.

• You can apply page setup options, such as scaling, orientation, and headers/footers, to multiple
worksheets at one time by grouping the worksheets.

Attribution

“6.4 Preparing to Print” by Mary Schatz and Julie Romey, Portland Community College is licensed under CC BY 4.0
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18. 6.5 Chapter Practice

CREATING A Multiple Sheet Workbook for a Sports Team

Data file: PR6 Data
You have just been hired by Pacific Northwest Soccer Club, and you quickly realize that there isn’t a consistent way for

all the coaches to keep track of their team statistics. To help with this, you decide to create a multiple sheet workbook
for Season Stats for each team. Since you are also the coach of the High Flyers Team this season, you will need to use
the workbook to enter your team’s statistics.

1. Open the data file PR6 Data and save the file to your computer as PR6 Pacific NW Sports Team.
2. Copy the range B11:G22 in the Season Stats sheet to the same range in the Player Stats sheet.
3. You will add formulas to this worksheet before entering the data later in the assignment. Group the sheets and add

the following formulas to both sheets:
4. In C22 and D22, you will need to count the Xs (that you will enter later) in rows 12 through 21. To do this, use the

COUNTA function. If necessary, review the COUNTA function in Chapter 2. Your formulas will return zeros for
now, until you enter the data.

5. In E22 and F22, sum rows 12 through 21.
6. In G12, calculate the Goal Percentage by dividing the number of Goals by the number of Shots. This formula will

display an error message because there is no data in column E (Excel shows the #DIV/0! error when a number is
divided by zero). We don’t want to display error messages, so an IF statement that tests the value of column E will
solve this problem.

7. Change the formula in G12 to an IF Function with the following three arguments:

◦ Test – is E12 greater than zero
◦ If the Test is True – divide the number of Goals by the number of Shots
◦ If the Test is False – enter a zero

8. Copy G12 down the column through G22. Format these cells as percentages.
9. Ungroup the sheets.

10. Save the file.
11. In the Season Stats sheet, enter the following data:

◦ D3 – High Flyers
◦ D4 – Fall and the current year (i.e. – Fall 2020)
◦ D5 – Pacific Northwest Soccer

12. Enter your name, phone number, and email address in row 8.
13. Make two copies of the Player Stats worksheet. Rename the Player Stats worksheets Player 1, Player 2 and Player

3.
14. Group the Player sheets only. Enter the following formulas:
15. A formula in D4 that points (links) to cell D3 in the Season Stats sheet. Your formula should be =’Season Stats’!D3.
16. A formula in D5 that points to cell D4 in the Season Stats sheet.
17. A formula in D6 that points to cell D5 in the Season Stats sheet.
18. Ungroup the sheets.
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19. Click on the Player 1 sheet. Enter the Player Name: Juan Ramirez. Enter the following data from Table 1 below:
Table 1: Player 1 Sheet

Played Started Shots Goals

Game 1 x x 2 1

Game 2 x x 3 1

Game 3

Game 4 x

Game 5 x x 2 0

Game 6 x

Game 7

Game 8 x x 1 1

Game 9 x x 4 2

Game 10 x x 3 3

20. Click on the Player 2 sheet. Enter the Player Name: Zach Johnson. Enter the following data from Table 2 below:
Table 2: Player 2 Sheet

Played Started Shots Goals

Game 1 x x 1 1

Game 2 x x 2 1

Game 3 x x 1 1

Game 4 x x 1 1

Game 5 x x 2 0

Game 6 x x 5 2

Game 7 x x 4 2

Game 8 x x 1 1

Game 9 x x 4 1

Game 10 x x 3 2

21. Click on the Player 3 sheet. Enter the Player Name: Vito Lawrenz. Enter the following data from Table 3 below:
Table 3: Player 3 Sheet
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Figure 6.14 Completed
Seasons Stats Sheet

Played Started Shots Goals

Game 1 x x 0 0

Game 2 x x 1 1

Game 3 x x 2 0

Game 4 x 1 1

Game 5 x x 2 0

Game 6 x x 3 1

Game 7 x x 2 1

Game 8 x x 1 1

Game 9 x x 1 1

Game 10 x x 1 1

22. Go to the Season Stats sheet and click on cell C12. Enter a 3-D formula to COUNTA (count the x’s) in C12 for the
Player 1 through Player 3 sheets. Copy the formula in C12 through D21.

23. Change the formulas in C22 and D22 from COUNTA to SUM.
24. Click on E12. Enter a 3-D formula to SUM cell E12 in the Player 1 through Player 3 sheets. Copy the formulas

through F21.
25. Preview the worksheets in Print Preview. Notice that only part of the data is printing for each worksheet. This is

because a Print Area was incorrectly set when the file was first created. You need to clear this Print Area for each
worksheet individually (modifying print areas cannot be done on grouped sheets). Exit Backstage View and for
each worksheet, click the Print Area button on the Page Layout tab and select Clear Print Area.

26. Group the sheets and add a Custom Footer that shows the Sheet Name in the center of the footer.
27. Double check Print Preview to make sure each sheet is printing on one page, and that the Sheet Name shows in

the center of the footer.
28. Your completed Seasons Stats sheet should look like Figure 6.14.

29. The formulas in row 12 of the Seasons Stats sheet should match Figure 6.15.
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Figure 6.15 Season Stats
Sheet Formulas in Row
12

30. Check the spelling on all of the worksheets and make any necessary changes.
31. Save the PR6 Pacific NW Sports Team workbook and submit as directed by your instructor.

Attribution

” 6.5 Chapter Practice” by Mary Schatz and Diane Shingledecker, Portland Community College is licensed under CC BY
4.0
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Appendix

Coming soon. Please see Glossaries at the end of each chapter.
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Glossary

Alignment Guide

A green vertical or horizontal line that displays when you are moving or sizing an object to assist with proper
placement

Artistic Effects

Formats applied to images that make pictures resemble sketches or paintings

Blank Document

A starting point for creating a new document in Microsoft Word

Blogs

A regularly updated website or web page, typically one run by an individual or small group, that is written in an
informal or conversational style

Booting

Booting is the process of turning on the computer and powering up the system.

Bulleted List

A list of items in no particular order that are preceded by a bullet for emphasis and organization

Bullets

Text symbols such as small circles that precede each item in a bulleted list

Cell

The intersection of a row and column in a table

Check Box

A small box which can be clicked to indicate a check is turned on or off to indicate an on or off response

Color Saturation

Intensity of the color; higher saturation makes a picture look more vivid, lower saturation makes the colors look
more grey

Cover Letter

A letter of introduction that highlights key points in the resume that follows

Ellipses

Informally as dot-dot-dot, is a series of dots that indicates an intentional omission of a word, sentence, or whole
section from a text without altering its original meaning. When selected, additional options appear
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Em Dash

A punctuation symbol that indicates and explanation or emphasis

Field

Placeholders that store and display data, and can perform simple tasks like returning the page number or current
date and time

Footer

The bottom margin of each page

Format Painter

Allows you to copy formatting from one item and apply it to another

Formatting Marks

Characters that display on the screen but do not print, indicating where the Enter key, the Spacebar, and Tab key
were pressed, also called non printing characters

Indentation

Specifies the distance between where the lines in a paragraph start in relation to the left or right margins

Inside Address

The name and address of the person of business received the letter, positioned below the date line

Keyboard Shortcut

One or more keys used to perform a menu function or other common functions

Layout Options

Picture formatting options that control the manner in which text wraps around a picture or other object

Leader

The space between tab stops can show a line, dots or dashes to line up information and guide the reader

Letterhead

The heading at the top of a sheet of letter paper that typically includes name and address or company logo.

Lock Anchor

A feature in word that allows you to move your image to any position on the same page as the anchor paragraph
which forces the object to stay in that position

Mini-Toolbar

Appears whenever you right-click text in Word, Excel or PowerPoint and provides a quick-access version of the
Font group on the Home tab, plus a few extra buttons from other groups
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Newsletter

A printed or electronic report containing news regarding updates for an organization or business and is sent to
interested parties

One-Click Row/Column Insertion

A feature in Word tables that allows users to insert a new row or column by pointing to the desired location and
then clicking once

Page Border

A decorative border that appears outside the margins on each page and can be solid, dashed, or an artistic style

Pictures

Images or graphics that are stored locally on a computer or flash drive and can be uploaded to a document to add
visual interest

Present Online

A Word feature that allows you to share your documents online using a web browser

Quick Access Toolbar

Located above the Ribbon (top-left) and provides access to commonly used features and commands, such as Save
and Undo/Redo, and is customizable

Quick Styles

An efficient way to add effects to a picture such as shape, border, and other effects

Resume

A formal document that provides an overview of professional qualifications for an employment opportunity

Resume Assistant

A feature in Word where you can see suggestions from LinkedIn to enhance your resume

Save As Dialog Box

Allows the user specify the drive, directory, and name of a file to save their file

Screen Clipping

Allows you to capture an image from your screen

Shape Effects

A grouping of coordinating effects that can be applied to a shape including shadows, glows, reflections, soft edges,
bevels, and three-dimensional (3-D) rotations

Shape Outline

Allows you to change the outline color, weight (thickness), and style of a the outline surrounding a shape
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Shape Styles

Allows you to apply preset colors and effects to quickly change the appearance of your shape

Shapes

Lines, arrows, starts, banners, ovals, rectangles, and other basic shapes with which you can illustrate an idea, a
process or a workflow

Sharpen/Soften

A way to enhance picture details or make pictures more appealing by removing unwanted blemishes on a picture

Small Caps

Allows you to capture an image from your screen

SmartArt

Horizontal position which is set for placing and aligning text on a page

Special Character

Normal characters that don't appear on standard keyboards; but once inserted into a Word doc, they look the same
as keyboard characters

Spelling and Grammar Check

Identifies spelling and grammatical errors and provides suggestions for correction

Square Text Wrapping

The manner in which text displays around an object

Tab Indicator

A button to the left of the ruler that provides tab marker options

Tab Stop

Horizontal position which is set for placing and aligning text on a page

Table

An arrangement of information organized into rows and columns

Tags

Any word, phrase, or number string related to the file that may help you locate the file later

Text Box

A moveable, resizable container for text or graphics

Text Effects and Topography

Decorative formats, such as shadowed or colors that make text stand out
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Toggle Button

A button that can be turned on and off by clicking it once to turn on, and clicking again to turn it off

Word Art

Gallery of text styles that you can add to your publications to create decorative effects, such as shadowed or
mirrored (reflected) text

Word Processing

The act of using a computer program to create, edit and print documents

Word Processor

Software or a device that allows users to create, edit, and print documents

YouTube

A free video sharing website
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